Value-Added Reseller (VAR) Language

Oracle Retail VAR Applications

The following restrictions and provisions only apply to the programs referred to in this section and licensed to you. You acknowledge that the programs may contain third party software (VAR applications) licensed to Oracle. Depending upon your product and its version number, the VAR applications may include:

(i) the MicroStrategy Components developed and licensed by MicroStrategy Services Corporation (MicroStrategy) of McLean, Virginia to Oracle and imbedded in the MicroStrategy for Oracle Retail Data Warehouse and MicroStrategy for Oracle Retail Planning & Optimization applications.

(ii) the Wavelink component developed and licensed by Wavelink Corporation (Wavelink) of Kirkland, Washington, to Oracle and imbedded in Oracle Retail Mobile Store Inventory Management.

(iii) the software component known as Access Via™ licensed by Access Via of Seattle, Washington, and imbedded in Oracle Retail Signs and Oracle Retail Labels and Tags.

(iv) the software component known as Adobe Flex™ licensed by Adobe Systems Incorporated of San Jose, California, and imbedded in Oracle Retail Promotion Planning & Optimization application.

You acknowledge and confirm that Oracle grants you use of only the object code of the VAR Applications. Oracle will not deliver source code to the VAR Applications to you. Notwithstanding any other term or condition of the agreement and this ordering document, you shall not cause or permit alteration of any VAR Applications. For purposes of this section, "alteration" refers to all alterations, translations, upgrades, enhancements, customizations or modifications of all or any portion of the VAR Applications including all reconfigurations, reassembly or reverse assembly, re-engineering or reverse engineering and recompiations or reverse compilations of the VAR Applications or any derivatives of the VAR Applications. You
acknowledge that it shall be a breach of the agreement to utilize the relationship, and/or confidential information of the VAR Applications for purposes of competitive discovery.

The VAR Applications contain trade secrets of Oracle and Oracle’s licensors and Customer shall not attempt, cause, or permit the alteration, decompilation, reverse engineering, disassembly or other reduction of the VAR Applications to a human perceivable form. Oracle reserves the right to replace, with functional equivalent software, any of the VAR Applications in future releases of the applicable program.
## Contents

**Send Us Your Comments** ........................................................................................................................................................................... ix

**Preface** ........................................................................................................................................................................................................... xi
  Audience ....................................................................................................................................................................................................... xi
  Documentation Accessibility ...................................................................................................................................................................................... xi
  Related Documents ................................................................................................................................................................................................ xi
  Customer Support ................................................................................................................................................................................................ xi
  Review Patch Documentation .................................................................................................................................................................................. xii
  Improved Process for Oracle Retail Documentation Corrections ........................................................................................................... xii
  Oracle Retail Documentation on the Oracle Technology Network .......................................................................................................... xiii
  Conventions ................................................................................................................................................................................................ xiii

1 **Overview**

  - **Brazil Localization Overview** ................................................................................................................................................................. 1-1
    - Nota Fiscal................................................................................................................................................................................................. 1-1
  - **About Oracle Retail Fiscal Management** ................................................................................................................................................. 1-1
  - **Business Processes** ................................................................................................................................................................................................ 1-2
    - Discrepancy Identification and Resolution Process .......................................................................................................................... 1-2

2 **Foundation Data**

  - **Foundation Data Setup** ................................................................................................................................................................................. 2-1
    - Requisition Types........................................................................................................................................................................................ 2-1
    - Nature of Operation.................................................................................................................................................................................... 2-2
    - Mode ................................................................................................................................................................................................................. 2-2
    - Utilization Code Maintenance........................................................................................................................................................................ 2-2
      - Adding Utilization Code ......................................................................................................................................................................... 2-2
      - Deleting Utilization Code .......................................................................................................................................................................... 2-3
    - Fiscal Utilization Options............................................................................................................................................................................. 2-4
      - Doc Type ...................................................................................................................................................................................................... 2-4
      - Adding Doc Type ..................................................................................................................................................................................... 2-4
      - Deleting Doc Type ................................................................................................................................................................................... 2-5
      - Parameters.................................................................................................................................................................................................... 2-5
      - Reason Code ................................................................................................................................................................................................ 2-7
    - Fiscal Document Types Maintenance.......................................................................................................................................................... 2-8
      - Fiscal Doc Type .................................................................................................................................................................................... 2-9
System Options ......................................................................................................................... 2-10
  Purge System Options ............................................................................................................... 2-10
  Discrepancy System Options .................................................................................................. 2-11
  Fiscal Management System Options ......................................................................................... 2-11
  Setting Up System Options ..................................................................................................... 2-18
Tolerance Parameter ..................................................................................................................... 2-19
  Setting up Tolerances ............................................................................................................ 2-19
Location Fiscal Numbers ........................................................................................................... 2-20
  Adding Fiscal Numbers ......................................................................................................... 2-20
  Deleting Fiscal Numbers ....................................................................................................... 2-21
  Viewing Fiscal Numbers ........................................................................................................ 2-22

3 Purchase Order

Business Flow ............................................................................................................................... 3-1
  NF Processing - PO Receiving ................................................................................................. 3-2
  Viewing the Error Log ............................................................................................................ 3-21
  NF Processing - Link and Delink ............................................................................................ 3-22
  Linking an NF to a Schedule ................................................................................................. 3-22
  Delinking an NF and a Schedule ........................................................................................... 3-23
Discrepancy Resolution .............................................................................................................. 3-23
  User Interface Indicators for Discrepancy ............................................................................ 3-24
  Centralized Resolution Discrepancy Process ........................................................................ 3-25
  Quantity Discrepancy ............................................................................................................ 3-25
    Return NF and Merchandise without NF Report Generation ............................................... 3-28
  De-centralized Discrepancy Resolution Process .................................................................... 3-29
  Cost Discrepancy .................................................................................................................. 3-29
    Printing Correction Documents .......................................................................................... 3-30
  Tax Discrepancy .................................................................................................................... 3-31
Complementary NF ....................................................................................................................... 3-34
Complementary NF for Triangulation ......................................................................................... 3-35
  Complementary NF Processing for Triangulation ................................................................. 3-35
Complementary NF for Non-Merchandise Cost ....................................................................... 3-36
  Complementary NF Processing for Non-Merchandise Cost .................................................. 3-37
Complementary NF for Cost/Tax Correction ........................................................................... 3-38
  Complementary NF Processing for Cost/Tax Correction ....................................................... 3-38
Deal Income Posting .................................................................................................................. 3-39
  Deal Types ............................................................................................................................ 3-39

4 Return to Vendor

Business Flow ............................................................................................................................... 4-1
  NF Processing for RTV with Balance Control Disabled ......................................................... 4-2
  NF Processing for RTV with Balance Control Enabled .......................................................... 4-4

5 Inventory Control

Transfers ....................................................................................................................................... 5-1
  Business Flow ......................................................................................................................... 5-1
9 Financial Postings

Business Flow ........................................................................................................................................ 9-1
Dynamic Segment Setup .................................................................................................................. 9-4
  Editing and Viewing the Dynamic Segment Configuration ...................................................... 9-5
General Ledger (GL) Cross Reference ........................................................................................... 9-6
Creating General Ledger Cross Reference ..................................................................................... 9-6
Chart of Accounts .............................................................................................................................. 9-9

10 StandAlone NF

Source Details Tab ........................................................................................................................... 10-1
Destination Details Tab .................................................................................................................. 10-3
Detail Info Tab ............................................................................................................................... 10-4
Additional Taxes Info Tab ............................................................................................................ 10-5

11 Invoice Receiving Layer Monitor

Options .................................................................................................................................................. 11-1
Status History Log ......................................................................................................................... 11-1
Validation Errors Log ................................................................................................................... 11-1
Revalidate .......................................................................................................................................... 11-1
Refusal ............................................................................................................................................. 11-2
Fiscal Document Preview Detail View ............................................................................................. 11-2
  Accessing the Fiscal Document Preview ....................................................................................... 11-2

Oracle welcomes customers’ comments and suggestions on the quality and usefulness of this document.

Your feedback is important, and helps us to best meet your needs as a user of our products. For example:

- Are the implementation steps correct and complete?
- Did you understand the context of the procedures?
- Did you find any errors in the information?
- Does the structure of the information help you with your tasks?
- Do you need different information or graphics? If so, where, and in what format?
- Are the examples correct? Do you need more examples?

If you find any errors or have any other suggestions for improvement, then please tell us your name, the name of the company who has licensed our products, the title and part number of the documentation and the chapter, section, and page number (if available).

---

**Note:** Before sending us your comments, you might like to check that you have the latest version of the document and if any concerns are already addressed. To do this, access the Online Documentation available on the Oracle Technology Network Web site. It contains the most current Documentation Library plus all documents revised or released recently.

---

Send your comments to us using the electronic mail address: retail-doc_us@oracle.com

Please give your name, address, electronic mail address, and telephone number (optional).

If you need assistance with Oracle software, then please contact your support representative or Oracle Support Services.

If you require training or instruction in using Oracle software, then please contact your Oracle local office and inquire about our Oracle University offerings. A list of Oracle offices is available on our Web site at [http://www.oracle.com](http://www.oracle.com).
Preface

The Oracle Retail Fiscal Management (ORFM) User Guide explains the new fiscal management system that handles the fiscal operations and requirements of the Brazilian fiscal system.

This guide describes the ORFM user interface. It provides step-by-step instructions to complete most tasks that can be performed through the user interface.

Audience

This User Guide is for users and administrators of Oracle Retail Product. This includes merchandisers, buyers, business analysts, and administrative personnel.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Related Documents

For more information, see the following documents in the Oracle Retail Fiscal Management Release 14.1.3 documentation set:

- Oracle Retail Merchandising System with Brazil Localization Installation Guide
- Oracle Retail Tax Integration Layer (RTIL) Installation Guide
- Oracle Retail RMS-ReSA User Guide for Brazil Localization and Online Help
- Oracle Retail Fiscal Management/RMS Brazil Localization Implementation Guide
- Oracle Retail Fiscal Management Data Model
- Oracle Retail Merchandising Batch Schedule
- Oracle Retail Fiscal Management Release Notes
Customer Support

To contact Oracle Customer Support, access My Oracle Support at the following URL:

https://support.oracle.com

When contacting Customer Support, please provide the following:

- Product version and program/module name
- Functional and technical description of the problem (include business impact)
- Detailed step-by-step instructions to re-create
- Exact error message received
- Screen shots of each step you take

Review Patch Documentation

When you install the application for the first time, you install either a base release (for example, 14.1) or a later patch release (for example, 14.1.3). If you are installing the base release, additional patch, and bundled hot fix releases, read the documentation for all releases that have occurred since the base release before you begin installation. Documentation for patch and bundled hot fix releases can contain critical information related to the base release, as well as information about code changes since the base release.

Improved Process for Oracle Retail Documentation Corrections

To more quickly address critical corrections to Oracle Retail documentation content, Oracle Retail documentation may be republished whenever a critical correction is needed. For critical corrections, the republication of an Oracle Retail document may at times not be attached to a numbered software release; instead, the Oracle Retail document will simply be replaced on the Oracle Technology Network Web site, or, in the case of Data Models, to the applicable My Oracle Support Documentation container where they reside.

This process will prevent delays in making critical corrections available to customers. For the customer, it means that before you begin installation, you must verify that you have the most recent version of the Oracle Retail documentation set. Oracle Retail documentation is available on the Oracle Technology Network at the following URL:

http://www.oracle.com/technetwork/documentation/oracle-retail-100266.html

An updated version of the applicable Oracle Retail document is indicated by Oracle part number, as well as print date (month and year). An updated version uses the same part number, with a higher-numbered suffix. For example, part number E123456-02 is an updated version of a document with part number E123456-01.

If a more recent version of a document is available, that version supersedes all previous versions.
Oracle Retail Documentation on the Oracle Technology Network

Oracle Retail product documentation is available on the following Web site:

http://www.oracle.com/technetwork/documentation/oracle-retail-100266.html

(Data Model documents are not available through Oracle Technology Network. You can obtain them through My Oracle Support.)

Conventions

The following text conventions are used in this document:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>boldface</td>
<td>Boldface type indicates graphical user interface elements associated with an action, or terms defined in text or the glossary.</td>
</tr>
<tr>
<td>italic</td>
<td>Italic type indicates book titles, emphasis, or placeholder variables for which you supply particular values.</td>
</tr>
<tr>
<td>monospace</td>
<td>Monospace type indicates commands within a paragraph, URLs, code in examples, text that appears on the screen, or text that you enter.</td>
</tr>
</tbody>
</table>
This user guide provides you information on how to effectively use Oracle Retail Fiscal Management (ORFM).

This chapter contains the following information:

- **Brazil Localization Overview**
- **About Oracle Retail Fiscal Management**
- **Business Processes**

**Brazil Localization Overview**

The movement of merchandise has to be accompanied by a fiscal document called Nota Fiscal (NF). The shipping location has to generate the NF. When the truck arrives at its destination, and before the physical receiving of the merchandise, the NF has to be validated against the Purchase Order (PO) and the Brazilian fiscal system, in order to ensure that all the taxes are applied correctly.

**Nota Fiscal**

The Nota Fiscal contains the following information:

- Transaction details, that is the items, and the quantities of items.
- Financial details, such as cost of the item.
- Taxation, and fiscal details such as tax codes, tax values, código fiscal de operações e prestações (CFOP), Cadastro Nacional de Pessoas Jurídicas (CNPJ), and other fiscal attributes used by the government to verify taxes for merchandise in transit.

The recipient of the merchandise has to ensure that the movement of merchandise is accompanied by a valid NF. In case of discrepancy, the shipment may be accepted by issuing supporting correction documents or the shipment may be rejected.

**About Oracle Retail Fiscal Management**

ORFM system enables you to verify the merchandise costs, quantities, and taxation details before payment. In ORFM, data can be entered manually, through Electronic Data Interchange (EDI), and the new electronic Invoice Receiving Layer (IRL). It integrates all the fiscal operations of the Brazilian fiscal system into RMS. It deals with creation of, and the receiving process of Nota Fiscals (NF), in addition to the issuing and printing of NF.
Business Processes

ORFM supports the following fiscal business operations:

■ PO Receiving – This is the regular buying process of a retailer. The retailer issues a purchase order (PO) when buying the merchandise from a supplier. When the merchandise is received, this merchandise is matched against the related PO in order to verify that the receiving merchandise has the items that the retailer has bought from the supplier. The retailer issues a PO when buying the merchandise from a supplier.

In case of discrepancies, the ORFM application supports resolving the cost, quantity, and tax discrepancy. For more information on how the application resolves the discrepancies, refer to the Discrepancy Identification and Resolution Process.

■ Transfers – Transfer is the movement of merchandise from one location to another, either a warehouse or a store. When the transfer is issued, ORFM creates and issues the related NF (based on the transfer information) for the merchandise to be transferred out. After the merchandise is shipped and received in the other location, another inbound NF is created to receive the merchandise in the receiving location.

■ Return to Vendor (RTV) – This business process needs the creation and issue of a NF in order to return the merchandise to the supplier. The ORFM application issues a NF for the merchandise to be sent back to the supplier.

■ Return from customers or Return Merchandise Authorization (RMA) – When customer returns merchandise, the retailer issues a RMA in order to receive the merchandise in the store. Since this operation involves the movement of merchandise, a NF has to be issued to receive it.

■ Triangulation Purchase Order – Triangulation is a process where in the retailer creates the PO with the main supplier to whom the payment is made. However, another supplier (a distributor or facilitator) actually delivers the stock on behalf of the main supplier (referred to as the delivery supplier).

■ NF-e Processing – Nota Fiscal Eletrônica (NF-e) or Electronic Fiscal Note is a project initiated by the Government of Brazil. The main objective is to replace the current system of issuing fiscal documents in paper with the electronic fiscal document.

Discrepancy Identification and Resolution Process

In the inbound PO process, additional validations and matching of quantity, tax, and cost have to be carried out before physical receiving of merchandising occurs. The retailer has to validate the correctness of the NF before approving the physical receipt. If there are any discrepancies in the quantity, tax, or cost, these have to be resolved before physical receipt of the merchandise can occur.

The overall discrepancy identification, and resolution process can be further divided into the following sub-processes:

■ Validation Process – The validation process includes validating the NF for errors like incorrect CFOP, header totals, etc. If there are errors on the NF, it is logged in

Note: ORFM Release 14.1.3 does not support Synchro tax engine integration.
the Error Log window. The NF has to be manually edited to resolve these errors, and the NF has to be re-validated. The validation process has the following three steps:

- **Data Integrity Validation** – In this process, all the NF totals are matched with the unit cost and quantity entered. This process takes into account the line item level and header level discounts, non-merchandise cost, insurance, miscellaneous expenses, and taxes while comparing the totals. If the data integrity validation fails, the NF will be in **Error** status. The NF has to be modified and re-validated before proceeding further.

- **Tax Engine Call for Tax Breakup** – A call is made to the Tax Engine for comparing the taxes on NF with system calculated taxes. The taxes returned by Tax Engine are stored at the individual item level. In case of any error during the Tax Engine call, status of the NF is changed to **Error**, and it has to be validated again.

- **Discrepancy Identification** – In this process, the unit cost of each item, quantity for each item and the taxes on the NF are compared with the corresponding values in the system. Any discrepancy identified during this process, the discrepancy indicators are marked appropriately on the NF header.

  ■ **Discrepancy Identification Process** – After validation, the discrepancy identification process is triggered. The quantity or cost discrepancy between the purchase order and NF, and tax discrepancy on the NF and the tax returned by Tax Engine is identified during this process. For tax discrepancy, the ORFM application validates that the NF has used the correct tax rules to calculate the taxes.

  ■ **Discrepancy Resolution Process** – Any discrepancies identified during the discrepancy identification process are available in the Discrepancy Resolution window. These discrepancies have to be resolved manually. In a centralized operation it is mandatory to resolve quantity discrepancies in order to proceed with physical receiving. In case of a de-centralized operation it is mandatory to resolve all discrepancies (cost, quantity and tax) in order to proceed with physical receiving.

  ■ **Generation of Return NF, and Merchandise without NF Report** – If the NF quantity is greater than the Open PO quantity, a return NF is generated, which is for the supplier to take back the excess stock. Sometimes, the merchandise is returned at the point of receipt in order to reduce shipping costs. The calculation of Return NF quantity and Merchandise without NF quantity is done after the physical receiving is done.

  ■ **Generation of Correction Letter** – A correction letter is generated when the PO cost/quantity/tax is different from the NF cost/quantity/tax, and the PO cost/quantity/tax is considered to be correct. The correction letter, with the PO values as the NF values, is automatically generated after all the discrepancies are resolved, depending on the discrepancy resolution action.
ORFM has its own Foundation Data. The foundation data has to be configured for the proper functioning of the ORFM application.

This chapter covers the following sections:

- Foundation Data Setup
- System Options
- Tolerance Parameter
- Location Fiscal Numbers

Foundation Data Setup

ORFM Foundation Data Setup includes setting up the utilization codes, related parameters, and document type codes.

Requisition Types

Requisition Type indicates the type of transaction that ORFM supports. ORFM supports the following requisition types:

- Purchase Order (PO) – This Requisition Type is applicable when there is movement of merchandise from a supplier to retailer’s location.
- Transfer (intra-company) – This Requisition Type is applicable when there is movement of merchandise from one location to another, either a warehouse or a store.
- Intercompany Transfer – This Requisition Type is applicable when there is a movement of merchandise between companies.
- Return to Vendor (RTV) – This Requisition Type is applicable when the merchandise is returned to the vendor.
- Repairing – This Requisition Type is applicable when merchandise is sent out to the external finisher or the supplier for finishing work (such as printing, dyeing, and embroidery) or repair (in the case of damaged goods).
- Return Merchandise Authorization (RMA) – This Requisition Type enables the retailer to pick up merchandise that is being returned from the customer.
- Inventory Adjustment – This Requisition Type enables total stock-on-hand adjustments or unavailable inventory for one or more item/locations.
- Direct NF - This Requisition Type is used to distinguish StandAlone NFs from Other NFs created within ORFM.
- Free Form NF - This Requisition Type is applicable when the user wishes to add generic items/services that are not present in RMS to the NF or use fiscal entities that are not defined in RMS. This is a StandAlone NF that is not related to any RMS transaction.

- Customer Order Drop Ship - This Requisition Type supports customer orders which will be shipped directly from the supplier to the customer, often referred to as drop ship orders.

- Sales: This Requisition Type supports any customer order transaction.

- Return NF: This Requisition Type supports automatic return to vendor NF generated, based on discrepancy treatment at receiving.

- PO for Rural Producer: This Requisition Type supports generation of Entry NF for Rural Producers.

- Stock Out: This Requisition Type supports NFs issued as a result of inventory adjustment.

### Nature of Operation

Nature of Operation (NOP) is a term used in Tax Engine. The nature of operations represents the transactions used to deduce the código fiscal de_operações e prestações (CFOP) codes in tax rules. There can be more than one utilization for the same NOP. For each Tax Engine call to retrieve taxes, ORFM returns the NOP related to the transaction to Tax Engine.

**Note:** ORFM and RMS are integrated with Tax Engine to get the tax break up for the NF. Tax Engine requires NOP to derive the CFOP before tax calculations. Therefore, ORFM maintains the list of NOP and enables you to link utilization and NOP.

### Mode

Mode indicates whether the NF is being created for inbound, or outbound operations. The possible values for Mode are Inbound (Entry), and Outbound (Exit).

### Utilization Code Maintenance

All merchandise in ORFM is associated with a utilization code. This code provides information about the transaction type and the NF related to the transaction. This information is used to determine the appropriate taxes for the merchandise as well as the impact on warehouse stock and on costs.

Each utilization code is linked to a Requisition Type, a NOP, and one or more document types.

**Note:** The utilization parameters are not available (dimmed) for the StandAlone NF.

### Adding Utilization Code

To add a Utilization Code, do the following:

**Navigate:** From the RMS Start Menu, select Fiscal Management, then Fiscal Configuration.
1. In the Contents Of Fiscal Configuration, select Fiscal Utilization.

2. In the Contents Of Fiscal Utilization window, click Edit. The Fiscal Utilization Setup window appears.

   **Note:** Click View in the Contents Of Fiscal Utilization window to view the fiscal utilization codes. In the View mode, the multi-record block is non-editable, and the Add and Delete buttons are disabled.

**Figure 2–1  Fiscal Utilization Setup Window**


4. Enter the Utilization Code, and Description. The Utilization Code is the unique identifier for each utilization. The Description column describes the fiscal utilization.

5. Select the Requisition Type from the list in the Req.Type column. The requisition types are: Purchase Order, Transfer, Return to Vendor, Return Merchandise Authorization, Stock Out, PO for Rural Producer, InterCompany Transfers, Repairing, Return NF, and Sales.

6. Select the Issue from the list in the Issue column. The issue types are: Issue or Include. The drop-down is enabled if the Requisition Type is either, Direct NF or Free from NF. The drop-down value of Issue indicates that the utilization code is relevant for cases wherein the Retailer is issuing the NF. When utilization codes classified as Issue are used for StandAlone NF creation, the Fiscal number, Serial, and Sub Serial Number fields are populated based on Location sequencing Logic. The drop-down value Include, indicates that the NF is issued by an external system. StandAlone NFs using utilization code classified as Include will have a mode type of entry and it allows for manual entry of the Fiscal number information.

7. Specify the Nature of Operation.

8. Enter the mode of operation. The Mode is either Entry or Exit.

**Deleting Utilization Code**

1. On the Fiscal Utilization Setup window, select the utilization you want to delete, and click Delete. The following message is displayed:
Figure 2–2  Message Window

2. Click Yes to delete the utilization.

Note: You can delete the utilization codes only if they are not associated with any NF.

Fiscal Utilization Options

The Fiscal Utilization Options menu consists of the following items:

- Doc Type
- Parameters
- Reason Code

Doc Type

The utilization code is linked to one or more document types, and each fiscal document type has to be associated with a utilization code.

Adding Doc Type

To add Doc Type to the Utilization Code, do the following:

Navigate: From the RMS Start Menu, select Fiscal Management, then select Fiscal Configuration.

1. In the Contents Of Fiscal Configuration window, select Fiscal Utilization.
2. In the Contents Of Fiscal Utilization window, click Edit. The Fiscal Utilization Setup window appears.

Note: Click View in the Contents Of Fiscal Utilization window to view the fiscal utilization codes. In the View mode, the multi-record block is non-editable, and the Add and Delete buttons are disabled.

3. In the Fiscal Utilization Setup window, select the Utilization Code for which Doc Types are being defined.
4. From the Options menu, select Doc Type. The Fiscal Utilization Document Type window appears.
5. Click **Add**. A highlighted blank row is displayed.
6. From the **Doc Type ID LOV**, select the value.
7. Click **OK** to exit the window.

**Deleting Doc Type**

To delete document types, do the following in the **Fiscal Utilization - Document Type** window:

1. Select the doc type that you want to delete. Click **Delete** in the **Fiscal Utilization - Document Type** window.
   
   A message appears. Click **Yes** to delete the document type.

2. Click **OK** to exit the window.

**Parameters**

Parameters are defined for each of the utilization codes.

To associate the parameters with the utilization codes, do the following:

**Navigate**: From the **RMS Start Menu**, select **Fiscal Management**, then select **Fiscal Configuration**.

In the **Contents Of Fiscal Utilization**, select **Edit**. The **Fiscal Utilization Setup window** appears.

1. On the **Fiscal Utilization Setup window**, click the **Options** menu.
2. Select **Parameters**. The **Fiscal Utilization Attributes window** appears.
3. Select or deselect the check boxes to configure the parameters for every Utilization Code.

Table 2-1 provides the list of parameters, and their description.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Complementary NF</td>
<td>When you select the Complementary NF check box, the Complementary NF Type list is enabled.</td>
</tr>
<tr>
<td>Complementary NF Type</td>
<td>Choose the Complementary NF type from the Complementary NF Type list:</td>
</tr>
<tr>
<td></td>
<td>▪ Triangulation</td>
</tr>
<tr>
<td></td>
<td>▪ Non-Merchandise cost</td>
</tr>
<tr>
<td></td>
<td>▪ Cost/Tax Correction</td>
</tr>
<tr>
<td></td>
<td>▪ Exit CNF</td>
</tr>
<tr>
<td>ICMS-ST Recovery</td>
<td>Select this check box to indicate that the particular transaction is marked for recovery of the Imposto sobre Circulação de Mercadorias e prestação de Serviços-Substituição Tributária (ICMS-ST) tax. This flag is used for entry and exit transactions. If the flag for entry or exit utilization is selected, the FlagGravaHistorico field is sent as the following values:</td>
</tr>
<tr>
<td></td>
<td>▪ If PO Receiving – Location has ST control and NF status = Approved and utilization = “ICMS-ST Recovery.” Send FlagGravaHistorico = 2.</td>
</tr>
<tr>
<td></td>
<td>▪ If NF Issuing – Location has ST control and Utilization = “Record ST.” Send FlagGravaHistorico = 3.</td>
</tr>
<tr>
<td>Item Utilization</td>
<td>This field is sent to Tax Rules when populating the Freight Object. Click the Item Utilization LOV to obtain the values. Following are the values displayed in the List of item Utilizations:</td>
</tr>
<tr>
<td></td>
<td>▪ Commercialization (C)</td>
</tr>
<tr>
<td></td>
<td>▪ Industrialisation (I)</td>
</tr>
</tbody>
</table>
Reason Code

The Reason Code is created by the retailer for inventory adjustment and repairing operations. It is used to identify returns and can be configured in the ORFM system.

<table>
<thead>
<tr>
<th>Note:</th>
</tr>
</thead>
<tbody>
<tr>
<td>■ Both Complementary NF and Complementary NF Type check boxes are dimmed if the utilization code are used in any NF.</td>
</tr>
<tr>
<td>■ If the Import Order Type is Direct Import, the Complementary NF cannot be setup as Triangulation as there is no Triangulation for Direct Import Order currently supported in the system.</td>
</tr>
</tbody>
</table>

To associate Reason Code with the Utilization Code, do the following:

Navigate: From the RMS Start Menu, select Fiscal Management, then select Fiscal Configuration.

1. On the Fiscal Utilization Setup window, click the Options menu.
2. Select the inventory adjustment for which you want to add the Reason Code. From the Options menu, select Reason Code. The Fiscal Utilization Reason Codes window appears.

Figure 2–5  Fiscal Utilization Reason Codes Window

3. Click Add. In the highlighted row that appears, select the reason code from the list.

4. Click OK. The reason code is associated with the inventory adjustment.

To delete the reason code, do the following in the Fiscal Utilization Codes Reason Codes window:

1. Select the reason code that you want to delete. Click Delete in the Fiscal Utilization Codes Reason Codes window. A message appears. Click Yes to delete the reason code.

2. Click OK to exit the window.

**Fiscal Document Types Maintenance**

The document type codes are defined by the fiscal authorities and each NF must have a document type code at the header level.

To associate Fiscal Document Types with a Utilization Code, do the following:

**Navigate:** From the RMS Start Menu, select Fiscal Management, then select Fiscal Configuration.

1. In Contents Of Fiscal Configuration window, select Fiscal Document Types.

3. Select the document type from the list. The list contains the all possible Fiscal Doc Types. The list displays the Fiscal Document Type ID and Description.

4. Click **Add** to add a fiscal document type. A new highlighted row is displayed.

5. The Description field displays the Fiscal Document Type description.

6. Click **OK** to exit the window.

To delete the document type, do the following:

1. Select the document type that you want to delete. Click **Delete**. A confirmation message appears.

2. Click **Yes** to delete the document type.

3. Click **OK** to exit the window.

**Fiscal Doc Type**

To associate the document type with the Utilization Code, do the following:

**Navigate:** From the **RMS Start Menu**, select **Fiscal Management**, then select **Fiscal Configuration**.

1. Select the document type to which you want to associate a Utilization Code.

2. Click **Util** in the Fiscal Document Type window. The Fiscal Doc Type Utilization window appears.
3. Click **Add** in the Fiscal Doc Type Utilization window.

4. A new row appears. Select the Utilization Code from the list.

5. Click **OK** to save your changes and exit the window.

To delete the utilization, do the following:

1. To delete a utilization, select the utilization, and click **Delete**.

2. Confirm the deletion in the message that appears. Click **OK** to exit the window.

### System Options

Set up the system configuration variables using the System Setup link.

The system options can be set up for the following operations:

- Purge
- Discrepancy
- Fiscal Management

### Purge System Options

These system options decide when the purge operations have to be implemented.

**Table 2–2  Purge System Options**

<table>
<thead>
<tr>
<th>System Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>History Days for IRL Tables</td>
<td>Number of days the data in IRL tables should be maintained.</td>
</tr>
<tr>
<td>Documents</td>
<td></td>
</tr>
<tr>
<td>History Days for History</td>
<td>Number of days the data in history table should be maintained.</td>
</tr>
<tr>
<td>Tables</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Table FM_NF_PURGE_DAYS_SETUP indicates the status and purge days are deleted.
**Discrepancy System Options**

These system options in ORFM decide what is the action that has to be taken for discrepancy resolution.

While resolving discrepancies, the values on the Purchase Order (PO) may be considered as correct, or the NF values may be considered as correct. In some cases, you can evaluate both the values, and decide what value to choose to resolve the discrepancy. In order to facilitate these requirements following three new system options are introduced:

<table>
<thead>
<tr>
<th>System Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantity Discrepancy Resolution Rule</td>
<td>This option can have the following values: System, Nota Fiscal and Reconcile. In case of quantity discrepancy, the system value is the PO value.</td>
</tr>
<tr>
<td>Cost Discrepancy Resolution Rule</td>
<td>This option can have the following values: System, Nota Fiscal and Reconcile. In case of cost discrepancy, the system value is the PO value.</td>
</tr>
<tr>
<td>Tax Discrepancy Resolution Rule</td>
<td>This option can have the following values: System, Nota Fiscal, and Reconcile. In case of tax discrepancy, system values are provided by the Tax Engine.</td>
</tr>
</tbody>
</table>

For more information about the usage of the system options set for discrepancy, see section *Discrepancy Identification and Resolution Process* in Chapter 1.

**Fiscal Management System Options**

The following system options help the fiscal management system to function successfully:

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALLOW_SUBMIT_DATE</td>
<td>Check Entry Or Exit Date and Exit Hour fields for all NF in a schedule during submit for receiving process is greater than system date</td>
</tr>
<tr>
<td>AVERAGE_TAX_RATE_SOURCE_ENTITY</td>
<td>Name of the authorized institute that provides the average cumulative tax rates for operations to end consumers.</td>
</tr>
<tr>
<td>BALANCE_CONTROL_RTV</td>
<td>Indicates whether the balance control for RTV is hold or not.</td>
</tr>
<tr>
<td>CALC_TOL_TYPE</td>
<td>For entry NF, indicate the calculation tolerance value.</td>
</tr>
<tr>
<td>COST_RESOLUTION_RULE</td>
<td>Default Resolution Action for Cost Discrepancies.</td>
</tr>
<tr>
<td>DEAL_DEF_CMPLX_TYPE</td>
<td>Default Document Type for complex deals.</td>
</tr>
<tr>
<td>DEAL_DEF_FXMRH_TYPE</td>
<td>Default Document Type for merchandise fixed deals.</td>
</tr>
<tr>
<td>DEAL_DEF_FXNMRH_TYPE</td>
<td>Default Document Type for non-merchandise fixed deals.</td>
</tr>
<tr>
<td>DEAL_DEFAULT_UTIL</td>
<td>Default Utilization ID for deals.</td>
</tr>
<tr>
<td>Variable</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>DEBIT_MEMO_TRAN_CODES</td>
<td>Tran Codes list which have to be posted as look up code CREDIT in AP header staging, field FISCAL_TYPE_LOOKUPO_CODE.</td>
</tr>
<tr>
<td>DEF_SFTW_COMPL_CT_DI_UTIL_ID</td>
<td>Default Utilization ID for SOFTWAY Complementary NF with Additional Cost/Tax.</td>
</tr>
<tr>
<td>DEF_SFTW_COMPL_NM_DI_UTIL_ID</td>
<td>Default Utilization ID for SOFTWAY Complementary NF with Non Merchandise Additional Cost.</td>
</tr>
<tr>
<td>DEFAULT_ACTION_REQ_PARM</td>
<td>Default Action Required Parametrization list of all NF status.</td>
</tr>
<tr>
<td>DEFAULTCANCEL_MESSAGE</td>
<td>Default Cancel Message for NFe Cancellation.</td>
</tr>
<tr>
<td>DEFAULT_COMP_COST_TAX_UTIL_ID</td>
<td>Default Utilization ID for complementary cost NF.</td>
</tr>
<tr>
<td>DEFAULT_COMP_FREIGHT_UTIL_ID</td>
<td>Default Utilization for complementary freight NF.</td>
</tr>
<tr>
<td>DEFAULT_COST_TAX_NOP</td>
<td>Default cost tax calls NOP.</td>
</tr>
<tr>
<td>DEFAULT_COUNTRY</td>
<td>Default supplier country.</td>
</tr>
<tr>
<td>DEFAULT_CURRENCY</td>
<td>Default currency code.</td>
</tr>
<tr>
<td>DEFAULT_DISCREP_LEGAL_MESSAGE</td>
<td>Stores the default legal message in SPED detail table, in field TXT, when discrepancy resolution is resolved by SYSTEM.</td>
</tr>
<tr>
<td>DEFAULT_DNF_STOCK_DOC_TYPE</td>
<td>Default Document Type for DNF Inventory Adjustments.</td>
</tr>
<tr>
<td>DEFAULT_DOCUMENT_TYPE</td>
<td>Default document type used by the process to create an EDI document based on external systems.</td>
</tr>
<tr>
<td>DEFAULT_DRSP_CO_PO_TYPE</td>
<td>Default PO Type for Drop Ship Customer Order when null in ORMS (fiscal utilization code in ORFM).</td>
</tr>
<tr>
<td>DEFAULT_FD_SALE_DOC_TYPE</td>
<td>Default Document Type for future delivery Customer Order SALE NF.</td>
</tr>
<tr>
<td>DEFAULT_FD_SALE_UTIL_ID</td>
<td>Default Utilization ID for future delivery Customer Order SALE NF.</td>
</tr>
<tr>
<td>DEFAULT_FD_SHIP_DOC_TYPE</td>
<td>Default Document Type for future delivery Customer Order Shipment NF.</td>
</tr>
<tr>
<td>DEFAULT_FD_SHIP_UTIL_ID</td>
<td>Default Utilization ID for future delivery Customer Order Shipment NF.</td>
</tr>
<tr>
<td>DEFAULT_FREIGHT_TYPE</td>
<td>Default freight type used by processes that issue NF as RTV, RNF, Transfers and RMA.</td>
</tr>
<tr>
<td>DEFAULT_IN_RET_IC_DOC_TYPE</td>
<td>Default Inbound Document Type for Return Transfers Inter Company.</td>
</tr>
<tr>
<td>DEFAULT_IN_RET_TSF_DOC_TYPE</td>
<td>Default Inbound Document Type for Return Transfers.</td>
</tr>
<tr>
<td>DEFAULT_IN_RETURN_ICUTIL_ID</td>
<td>Default Utilization ID for Return Transfers Inter-Company.</td>
</tr>
<tr>
<td>DEFAULT_IN_RETURN_TSF_UTIL_ID</td>
<td>Default Inbound Utilization ID for Return Transfers.</td>
</tr>
<tr>
<td>Variable</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>DEFAULT_INBOUND_IC_DOC_TYPE</td>
<td>Default Document Type for Inbound IC Transfers.</td>
</tr>
<tr>
<td>DEFAULT_INBOUND_IC_UTIL_ID</td>
<td>Default Utilization ID for Inbound IC Transfers.</td>
</tr>
<tr>
<td>DEFAULT_INBOUND_REP_DOC_TYPE</td>
<td>Default Document Type for Inbound Repairing Transfers.</td>
</tr>
<tr>
<td>DEFAULT_INBOUND_REP_UTIL_ID</td>
<td>Default Utilization ID for Inbound Repairing Transfers.</td>
</tr>
<tr>
<td>DEFAULT_INBOUND_TSF_DOC_TYPE</td>
<td>Default Document Type for Inbound Transfers.</td>
</tr>
<tr>
<td>DEFAULT_INBOUND_TSF_UTIL_ID</td>
<td>Default Utilization ID for Inbound Transfers.</td>
</tr>
<tr>
<td>DEFAULT_JUSTIF_NULLIFICATION</td>
<td>Default Justification for NF Nullification.</td>
</tr>
<tr>
<td>DEFAULT_NFCE_DOC_TYPE</td>
<td>Default Document Type for NFCe.</td>
</tr>
<tr>
<td>DEFAULT_NFCE_MODEL_CODE</td>
<td>Default Model Code for Customer NFe (NFCe).</td>
</tr>
<tr>
<td>DEFAULT_NFE_DOC_TYPE</td>
<td>Default Document Type for NFE.</td>
</tr>
<tr>
<td>DEFAULT_NFE_IND_TYPE</td>
<td>Default NFe indication.</td>
</tr>
<tr>
<td>DEFAULT_NFE_MODEL_CODE</td>
<td>Default Model Code for NFE.</td>
</tr>
<tr>
<td>DEFAULT_NOP</td>
<td>Default Nature of Operation.</td>
</tr>
<tr>
<td>DEFAULT_ORIGIN_CODE</td>
<td>Retrieve Default Origin Code case user does not inform.</td>
</tr>
<tr>
<td>DEFAULT_OUT_RET_IC_DOC_TYPE</td>
<td>Default Outbound Document Type for Return Transfers Inter Company.</td>
</tr>
<tr>
<td>DEFAULT_OUT_RET_TSF_DOC_TYPE</td>
<td>Default Outbound Document Type for Return Transfers.</td>
</tr>
<tr>
<td>DEFAULT_OUT_RETURN_IC_UTIL_ID</td>
<td>Default Outbound Utilization ID for Return Transfers Inter-Company.</td>
</tr>
<tr>
<td>DEFAULT_OUT_RETURN_TSF_UTIL_ID</td>
<td>Default Outbound Utilization ID for Return Transfers.</td>
</tr>
<tr>
<td>DEFAULT_OUTBOUND_CUST_UTIL_ID</td>
<td>Default Utilization ID for outbound customer order transfers.</td>
</tr>
<tr>
<td>DEFAULT_OUTBOUND_IC_DOC_TYPE</td>
<td>Default Document Type for Outbound IC Transfers.</td>
</tr>
<tr>
<td>DEFAULT_OUTBOUND_IC_UTIL_ID</td>
<td>Default Utilization ID for Outbound IC Transfers.</td>
</tr>
<tr>
<td>DEFAULT_OUTBOUND_REP_DOC_TYPE</td>
<td>Default Document Type for Outbound Repairing Transfers.</td>
</tr>
<tr>
<td>DEFAULT_OUTBOUND_REP_UTIL_ID</td>
<td>Default Utilization ID for Outbound Repairing Transfers.</td>
</tr>
<tr>
<td>DEFAULT_OUTBOUND_TSF_DOC_TYPE</td>
<td>Default Document Type for Outbound Transfers.</td>
</tr>
</tbody>
</table>
Table 2–4  (Cont.) Fiscal Management System Options

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DEFAULT_OUTBOUND_TSF_UTIL_ID</td>
<td>Default Utilization ID for Outbound Transfers.</td>
</tr>
<tr>
<td>DEFAULT_PAYMENT_METHOD</td>
<td>Default Payment Method.</td>
</tr>
<tr>
<td>DEFAULT_PO_TYPE</td>
<td>During PO migration, it is used to provide fiscal utilization used in these migrated PO.</td>
</tr>
<tr>
<td>DEFAULT_PRENF_SERIES</td>
<td>Default PRENF series. Used in issue NF that is not get official sequence number.</td>
</tr>
<tr>
<td>DEFAULT_PRESENCE_IND_CO</td>
<td>Default presence indicator.</td>
</tr>
<tr>
<td>DEFAULT_PRESENCE_IND_NFCE</td>
<td>Default presence indicator for NFCE.</td>
</tr>
<tr>
<td>DEFAULT_PRESENCE_IND_NFE</td>
<td>Default presence indicator for NFE.</td>
</tr>
<tr>
<td>DEFAULT_REASN_FOR_RTRN</td>
<td>Default Reason for a Return Document.</td>
</tr>
<tr>
<td>DEFAULT_REF_MESSAGE</td>
<td>This NF number %s1 is referenced to the original NF %s2 issued on %s3 respectively.</td>
</tr>
<tr>
<td>DEFAULT_REF_MESSAGE_FDSHIP</td>
<td>Default legal message to inform the relation between the Shipment NF and the Sale NF in a future delivery scenario.</td>
</tr>
<tr>
<td>DEFAULT_REF_MESSAGE_ICMS_ST</td>
<td>ICMS-ST retido anteriormente, Base Cálculo R$ %s1, Valor Retido R$ %s2.</td>
</tr>
<tr>
<td>DEFAULT_REF_MESSAGE_RTV</td>
<td>Devolução ref. a NF n° %s1, emitida em %s2, Valor de R$ %s3.</td>
</tr>
<tr>
<td>DEFAULT_RETAIL_TAX_NOP</td>
<td>Default retail tax calls NOP.</td>
</tr>
<tr>
<td>DEFAULT_RMA_DOC_TYPE</td>
<td>Default Document Type for RMA.</td>
</tr>
<tr>
<td>DEFAULT_RMA_UTIL_ID</td>
<td>Default Utilization ID for RMA.</td>
</tr>
<tr>
<td>DEFAULT_RNF_DOC_TYPE</td>
<td>Default Document Type for Return NF.</td>
</tr>
<tr>
<td>DEFAULT_RNF_UTILIZATION_ID</td>
<td>Default Utilization ID for Return NF.</td>
</tr>
<tr>
<td>DEFAULT_RTV_DOC_TYPE</td>
<td>Default Document Type for RTVs.</td>
</tr>
<tr>
<td>DEFAULT_RTV_DOC_TYPE_TRIANG</td>
<td>Default Document Type for Triangulation RTVs.</td>
</tr>
<tr>
<td>DEFAULT_RTV_UTIL_ID</td>
<td>Default Utilization ID for RTVs.</td>
</tr>
<tr>
<td>DEFAULT_RTV_UTIL_TRIANG_ID</td>
<td>Default Utilization ID for outbound RTV NF for the Supplier Delivery in a triangular operation purchase.</td>
</tr>
<tr>
<td>DEFAULT_RURAL_PROD_DOC_TYPE</td>
<td>Default Document Type for Rural Producer NF.</td>
</tr>
<tr>
<td>DEFAULT_RURAL_PROD_UTILIZATION</td>
<td>Default Utilization ID for Rural Producer NF.</td>
</tr>
<tr>
<td>DEFAULT_SOFTWAY_DI_UTIL_ID</td>
<td>Default Utilization ID for NF issued by RFM that imported from SOFTWAY DI NFs through EDI process.</td>
</tr>
<tr>
<td>Variable</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>DEFAULT_STOCK_DOC_TYPE</td>
<td>Default Document Type for Inventory Adjustments.</td>
</tr>
<tr>
<td>DEFAULT_TRIANGULATION_UTIL_ID</td>
<td>Default Utilization ID to use in triangulation NF that came from IRL.</td>
</tr>
<tr>
<td>DEFT_MULTISITE_CO_IN_IC_DOC</td>
<td>Default Document Type for Multisite Customer Order Inbound IC Transfers.</td>
</tr>
<tr>
<td>DEFT_MULTISITE_CO_IN_IC_UTIL</td>
<td>Default Utilization ID for Multisite Customer Order Inbound IC Transfer.</td>
</tr>
<tr>
<td>DEFT_MULTISITE_CO_IN_TSF_DOC</td>
<td>Default Document Type for Multisite Customer Order Inbound Transfer.</td>
</tr>
<tr>
<td>DEFT_MULTISITE_CO_IN_TSF_UTIL</td>
<td>Default Utilization ID for Multisite Customer Order Inbound Transfer.</td>
</tr>
<tr>
<td>DEFT_MULTISITE_CO_OUT_IC_DOC</td>
<td>Default Document Type for Multisite Customer Order Outbound IC Transfers.</td>
</tr>
<tr>
<td>DEFT_MULTISITE_CO_OUT_IC_UTIL</td>
<td>Default Utilization ID for Multisite Customer Order Outbound IC Transfers.</td>
</tr>
<tr>
<td>DEFT_MULTISITE_CO_OUT_TSF_DOC</td>
<td>Default Document Type for Multisite Customer Order Outbound Transfer.</td>
</tr>
<tr>
<td>DEFT_MULTISITE_CO_OUT_TSF_UTIL</td>
<td>Default Utilization ID for Multisite Customer Order Outbound Transfer.</td>
</tr>
<tr>
<td>DEFT_SALE_CO_DOC_TYPE</td>
<td>Default Doc Type for Outbound CO.INTER-State: All. INTRA-State: Addressee is NOT an End Consumer or an ICMS Contributor.</td>
</tr>
<tr>
<td>DEFT_SALE_CO_DOC_TYPE_INTRA</td>
<td>Default Doc Type for Outbound CO. INTRA-State: Addressee must be an End Consumer and must NOT be an ICMS Contributor.</td>
</tr>
<tr>
<td>DI_NF_SERIAL_GENERATION_IND</td>
<td>Indicates which trading system being used. It can be either Softway(S) or some Third party system(T).</td>
</tr>
<tr>
<td>DOC_TYPE_PO</td>
<td>Default fiscal document type code (e.g. 1 - Nota Fiscal - Modelo 1, 1A).</td>
</tr>
<tr>
<td>EDI_DEF_PTNR_ID</td>
<td>Indicates the default partner ID, in Transportation Details tab used in NFs created by screen and EDI.</td>
</tr>
<tr>
<td>EDI_DEF_PTNR_TYPE</td>
<td>Indicates the default partner type, in Transportation Details tab used in NFs created by screen and EDI.</td>
</tr>
<tr>
<td>ENABLE_ACCOUNTING_REVERSAL</td>
<td>Indicates whether to revert accounting information for cancelled Nota Fiscal.</td>
</tr>
<tr>
<td>ENABLE_AUTO_UPDATE_ORIGIN_FCI</td>
<td>Enables auto update for Item-Location Origin and FCI.</td>
</tr>
<tr>
<td>ENABLE_DEBUG</td>
<td>Indicates whether to save the debug messages on the debug table (FM_DEBUG).</td>
</tr>
<tr>
<td>ENABLE_SIM_WS_INTEGRATION</td>
<td>Identify if when there is a NF cancellation RFM will call the SIM Inv Adj Web Service to. Valid values should be Y or N.</td>
</tr>
<tr>
<td>END_CONSUMER_MAX_VALUE</td>
<td>Default End Customer Max Value.</td>
</tr>
</tbody>
</table>
**Table 2-4 (Cont.) Fiscal Management System Options**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EXT_TAX_PROVIDER</td>
<td>Indicates which external tax provider is integrated with the system.</td>
</tr>
<tr>
<td>FISCAL_CANCEL_ROLE</td>
<td>Role with privilege to NFE cancel.</td>
</tr>
<tr>
<td>FM_FRECLASS_ACTIVE_DATE</td>
<td>Minimum number of days of active date to item fiscal reclassification from system date. If 0 means change is done immediately.</td>
</tr>
<tr>
<td>FM_FRECLASS_COPY_DOWN_CHILD</td>
<td>In process of fiscal item reclassification is copy classification item parent to child.</td>
</tr>
<tr>
<td>FM_FRECLASS_ONLINE_IND</td>
<td>Define information that can be edit in screen.</td>
</tr>
<tr>
<td>FM_FRECLASS_PURGE</td>
<td>Minimum Days to keep records of item fiscal reclassification lots after purge batch execution.</td>
</tr>
<tr>
<td>HISTORY_DAYS_GTAX_ITEM_ROLLUP</td>
<td>Number of days in the past that will be used for purge to TAX_ITEM_ROLLUP_HIST.</td>
</tr>
<tr>
<td>HISTORY_DAYS_HIST_TABLES</td>
<td>Number of days the history table can hold the records.</td>
</tr>
<tr>
<td>HISTORY_DAYS_POS_MODS_TAX_INFO</td>
<td>Number of days in the past that will be used for purge to POS_MODS_TAX_INFO_HIST.</td>
</tr>
<tr>
<td>HISTORY_DAYS_PROCESSEDEDI</td>
<td>Number of days the EDI NFs can exist in the EDI tables before getting purged.</td>
</tr>
<tr>
<td>HOUR_FORMAT</td>
<td>Format to represent fields of hour. Must be HH24:MI or HH:MI AM.</td>
</tr>
<tr>
<td>IRL_ALLOWEDMULTISITE</td>
<td>Indicates if IRL Monitor allows multisite treatment.</td>
</tr>
<tr>
<td>IRL_ALLOWEDWORKSHEET</td>
<td>Indicates if WORKSHEET option will be available for IRL.</td>
</tr>
<tr>
<td>IRL_AUTOREFUSAL</td>
<td>Indicates if IRL allows automatic refusal in Pre-validation.</td>
</tr>
<tr>
<td>IRL_AUTOREFUSALDESCRIPTION</td>
<td>Indicates the default reason description to Automatic Refusal.</td>
</tr>
<tr>
<td>IRL_PURGEDAYS</td>
<td>Indicates the number of days for purge the IRL tables.</td>
</tr>
<tr>
<td>IRL_REASONDESCRIPTION</td>
<td>Indicates if IRL Receipt Refusal requires reason description.</td>
</tr>
<tr>
<td>IRL_SEFAZVALIDATION</td>
<td>Indicates if IRL SEFAZ validation is required.</td>
</tr>
<tr>
<td>IRL_XML_DATABASE_BKP</td>
<td>Indicates if IRL allows storing XML into database.</td>
</tr>
<tr>
<td>MANUAL_APPROVAL_PROTOCOL_MASK</td>
<td>Manual approval protocol mask.</td>
</tr>
</tbody>
</table>
### Table 2–4 (Cont.) Fiscal Management System Options

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MANUAL_CANCEL_ROLE</td>
<td>Role with privilege to NFE manual cancel.</td>
</tr>
<tr>
<td>NF_BREAKUP_TAX_REGIME</td>
<td>Identify the attribute for breaking the NF.</td>
</tr>
<tr>
<td>NF_MAX_ITEM</td>
<td>Maximum allowable line items on NF during the issue. If number of items is greater than defined in this parameter, from next item will be issued in other NF.</td>
</tr>
<tr>
<td>NUMBER_FORMAT</td>
<td>Value Field Format.</td>
</tr>
<tr>
<td>NUMBER_FORMAT_4</td>
<td>Value Field Format for 4decimal.</td>
</tr>
<tr>
<td>ORFMI_MAX_DAYS</td>
<td>Number of days minus the ORFMi date.</td>
</tr>
<tr>
<td>ORFMI_MIN_DAYS</td>
<td>Number of days minus the ORFMi date.</td>
</tr>
<tr>
<td>ORFMO_MAX_DAYS</td>
<td>Number of days minus the ORFMo date.</td>
</tr>
<tr>
<td>ORFMO_MIN_DAYS</td>
<td>Number of days minus the ORFMo date.</td>
</tr>
<tr>
<td>PERCENT_FORMAT</td>
<td>Percentage Field Format.</td>
</tr>
<tr>
<td>PRIORITY_TSF_IPI_IMPORTED</td>
<td>Indicates the priority of import or non-imported stock on first exit.</td>
</tr>
<tr>
<td>PURGE_DAYS</td>
<td>Days before records are purged from the tables.</td>
</tr>
<tr>
<td>QTY_FORMAT</td>
<td>Quantity Field Format</td>
</tr>
<tr>
<td>QTY_RESOLUTION_RULE</td>
<td>Default Resolution Action for Quantity Discrepancies.</td>
</tr>
<tr>
<td>REASON_ID_INVADJ_SIM_WS_INT</td>
<td>This variable holds the reason ID used for integration with SIM Inventory Adjustment Web Service.</td>
</tr>
<tr>
<td>RECOVERABLE_TAX_CST</td>
<td>Value related to the selected CST.</td>
</tr>
<tr>
<td>REF_NF_MANDATORY_FREIGHT</td>
<td>Indicates if it is mandatory to inform the reference NF for Complementary NF Freight.</td>
</tr>
<tr>
<td>REF_NF_MANDATORY_RTV</td>
<td>Indicates if it is mandatory to inform the reference NF for RTV NF issues.</td>
</tr>
</tbody>
</table>
To set up the System Options, do the following:

Navigate: From the RMS Start Menu, select Fiscal Management, then select System Setup.

1. In the Contents Of System Setup window, select System Options.
2. In the Contents Of System Options window, click Edit. The System Options window appears.

Figure 2–8 System Options Window

3. Click the Variable field LOV to view the description and variables.
4. Click Add. A new row is displayed.

**Note:** Adding parameters will not have any impact on the system functionality.

5. Enter the details in the Variable and Description fields.
6. Select the Type from the list.

### Table 2–4 (Cont.) Fiscal Management System Options

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>STOCK_REVERSAL_VIRTUAL_STORE</td>
<td>Holds the default virtual store that will be used in the inventory reversal process to put merchandise back to the WH.</td>
</tr>
<tr>
<td>TAX_RESOLUTION_RULE</td>
<td>Default Resolution Action for Tax Discrepancies.</td>
</tr>
<tr>
<td>TSF_PURCHASE_PRICE</td>
<td>Indicates whether last purchase price(Y) OR WAC(N) as valid value when issue a transfer NF.</td>
</tr>
</tbody>
</table>
7. Enter the details in the Value field.
8. Click OK to exit the window.

**Tolerance Parameter**

Tolerance is the variance allowed between a NF and the requisition document, and also within a NF. If the NF is within tolerances, then the NF can be considered matched (without discrepancy). ORFM supports the following three types of tolerances:

- **Cost Tolerance:** Use it when comparing the unit cost of the item on the PO as against the unit cost of the item on the NF.
- **Quantity Tolerance:** Use it when matching the quantity ordered, against the quantity provided in NF for each item.
- **Calculation Tolerance:** Use it to avoid the NFs from going into discrepancies due to rounding or truncation issues.

**Note:** The cost, and quantity tolerances can be set in the Tolerance Maintenance screen of the ORFM, and calculation can be set as a system variable.

**Setting up Tolerances**

To set up the tolerances, do the following:

**Navigate:** From the RMS Start Menu, select Fiscal Management, then select System Setup.

1. In the Contents Of System Setup window, select Tolerances.
2. In the Contents Of Tolerances window, click Edit. The Tolerances window appears.

**Figure 2–9 Tolerances Window**

3. In the Tolerances window, the list in the Level field has two values – Supplier, and Company. Select the level applicable.
4. The Name field displays the list of all the Supplier names or Company names based on the level selected. Select the supplier, or the company name.

5. Click **Search**. The existing tolerances for the supplier or company is displayed in the multi-record block. If there are no tolerances for the selected level, the following message is displayed: "Query caused no records to be retrieved".

6. If there are tolerances for the selected values, the following parameters are displayed in the multi-record block:
   - Tolerance Level – Choose from Line Quantity, and Line Cost.
   - Lower Limit Inclusive – The lower limit for the range. This value is included in the range.
   - Upper Limit Exclusive – The upper limit for the range. This value is excluded from the range.
   - Tolerance Type – Select the Requisition Document Tolerance Type from the list. The list includes Percentage or Value.
   - Tolerance Value – Enter the tolerance value for matching between the NF and the requisition document of the NF.

7. Click **OK** to save the changes.

The other options available on the window includes:
   - Click **Add** to add a new row in the multi-record block.
   - Click **Delete** to delete the selected row from the multi-record block.
   - Click **Refresh** to clear the filter criteria, and the data in the multi-record block.
   - Click **Cancel** if you do not want to save the changes that you have entered.

---

**Note:** Select **View** mode in the Contents Of Tolerances window to view the tolerances. The **Add** and **Delete** button in the Tolerances window are disabled.

---

**Location Fiscal Numbers**

Location Fiscal Numbers are numbers assigned to a store/warehouse. In Brazil, the sequence of NF document numbers are controlled and should be correctly followed during the NF issuing process.

Each location controls its own sequence based on the following fields:
   - Documentation Type
   - Serial/Sub-serial
   - Sequence
   - Effective Date

Any transaction that involves that particular store/warehouse should contain the fiscal numbers falling within a particular range.

**Adding Fiscal Numbers**

To add fiscal numbers, do the following:
Navigate: From the RMS Start Menu, select Fiscal Management, then System Setup. From System Setup, select Fiscal Numbers.

1. In the Contents Of Fiscal Numbers window, click Edit. The Location Fiscal Numbers window appears.

Figure 2–10  Location Fiscal Numbers Window

2. To add a number, select the store/warehouse from the Location LOV. Click Add. In the multi-record block, a row is highlighted as shown.

Figure 2–11  Location Fiscal Numbers Window

3. Assign values to Location, Document Type, Series Number, Subseries Number, Minimum Fiscal Number, Maximum Fiscal Number, and Effective Date.

Deleting Fiscal Numbers

1. Select the row that you want to delete in the Location Fiscal Numbers window.
2. Click **Delete**. The following message appears:

*Figure 2–13  Location Fiscal Numbers - Delete window*

![Delete Window](image)

3. Click **Yes** to delete the row.

**Viewing Fiscal Numbers**

1. In the Contents Of Fiscal Numbers window, click **View**. The Location Fiscal Numbers window appears.

   In the View mode, the **Add**, and the **Delete** button are disabled. By default, the Location Fiscal Numbers displays the locations, and their fiscal numbers.

*Figure 2–14  Location Fiscal Numbers Window*

![View Window](image)

2. Select the location type from the Location Type list. The Location field is highlighted after selecting the location type.
3. Select the location from the Location LOV.

4. Click the filter icon. Based on the filter criteria, the multi-record block displays the Location Type, the Location, and the values associated with the Document Type, Series Number, Subseries Number, Minimum Fiscal Number, Maximum Fiscal Number, and Effective Date.
Purchase Order (PO) is the regular buying process of a retailer. The retailer issues a PO when buying the merchandise from a supplier. When the merchandise is received, this merchandise is matched against the related PO in order to verify that the receiving merchandise has the items that the retailer has bought to the supplier.

This chapter covers the following sections:

- Business Flow
- Discrepancy Resolution
- Complementary NF
- Complementary NF for Triangulation
- Complementary NF for Non-Merchandise Cost
- Complementary NF for Cost/Tax Correction
- Deal Income Posting

### Business Flow

The business flow for PO receiving is as follows:

1. Retail Fiscal Management (ORFM) system can receive Nota Fiscal (NF) by:
   - Manual
   - EDI
   - Invoice Receiving Layer
2. When the shipment arrives at the warehouse or the store, create a schedule and enter the NFs received.

---

**Note:**

- You can link more than one NF to a schedule.
- The schedule can be created before or after creating an NF.
- An NF can be created without a schedule, but they have to be linked before submitting for receiving.

3. After NF entry, validate the NFs. In the validation process, the ORFM application checks for data integrity. Match the NF with the requisition documents in the Retail Merchandising System (RMS). This process is called as the Fiscal Receiving.
If the NF and the PO does not match, the NF is in discrepancy. You can identify the following discrepancies with the ORFM application:

- Unit Cost Discrepancy for each item in the NF
- Quantity Discrepancy for each item in the NF
- Tax Discrepancy happens between system (tax details from Tax Engine) and NF.

4. After validation, send the schedule to the warehouse management system and store inventory management system. After physical receiving, both the systems publish the receipt updates to ORFM. This completes the NF processing.

5. Send the transaction data in RMS and ORFM to a financial application. For fiscal reporting purposes, send the NF data in ORFM to the fiscal reporting system like SPED.

**NF Processing - PO Receiving**

The Receiving/Issuing module of ORFM enables you to create the required NF. This module enables you to validate the NF, match the NF with the PO, resolve discrepancy, and approve the NF with correction documents.

To create the Nota Fiscal for PO Receiving, perform the following steps:

**Navigate**: From the RMS Start Menu, select Fiscal Management, then Login of Location. The Location Login window is displayed.

1. In the Location Login window, select the store or warehouse for receiving/issuing the fiscal document. Click the Location LOV to obtain the list of stores or warehouses. Select the location, and click OK.

   ![Location Login Window](image.png)

2. You are returned to the RMS main screen. In Contents Of Fiscal Management, select Receiving/Issue.

   In Contents Of Receiving/Issue, click Edit. The Receiving/Issue Schedule window is displayed.
3. Select the Mode from the list. For PO receiving, select **Entry**.

   The other option available is **Exit**. This mode is for outbound flow.

4. The Filter section in the Receiving/Issue Schedule window displays the following:
   - Location Type – This field displays the information that flows from the Location Login window. The list contains Store or Warehouse.
   - Location – The sender/receiver location.
   - Schedule – Select the schedule number from the Schedule LOV or click **Add** to create a new schedule number.
   - Select the appropriate status from the list in the Status field. For PO Receiving, the status has to be Worksheet.

### Schedules with physical receiving

For Entry type of Schedules where physical receiving is required such as PO receiving or TSF receiving:

<table>
<thead>
<tr>
<th>Code</th>
<th>Schedule Status</th>
<th>Status Type</th>
<th>NF Status in Receiving Process</th>
</tr>
</thead>
<tbody>
<tr>
<td>W</td>
<td>Worksheet</td>
<td>Inclusive</td>
<td>In Discrepancy</td>
</tr>
<tr>
<td>P</td>
<td>Pending for Receiving</td>
<td>Exclusive</td>
<td>Validated Calculated</td>
</tr>
<tr>
<td>S</td>
<td>Subm. for Recv.</td>
<td>Exclusive</td>
<td>Verifying NFe Status</td>
</tr>
</tbody>
</table>
Entry schedule status

Inactive can be: ‘Reject Entire Receiving from WMS/SIM’ or ‘entry NF was rejected’.

**Schedules with shipments**

For Exit type of Schedules where shipment is done in order to generate NFs:

<table>
<thead>
<tr>
<th>Code</th>
<th>Schedule Status</th>
<th>Status Type</th>
<th>NF Status in Receiving Process</th>
</tr>
</thead>
<tbody>
<tr>
<td>R</td>
<td>Received</td>
<td>Inclusive</td>
<td>Received</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Receipt-Verified</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Manifest Pending</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Post Sefaz Approve Error</td>
</tr>
<tr>
<td>A</td>
<td>Approved</td>
<td>Exclusive</td>
<td>Approved</td>
</tr>
<tr>
<td>C</td>
<td>Completed</td>
<td>Exclusive</td>
<td>Completed</td>
</tr>
<tr>
<td>FP</td>
<td>Financials Posted</td>
<td>Exclusive</td>
<td>Financials Posted</td>
</tr>
<tr>
<td>I</td>
<td>Inactive</td>
<td>Exclusive</td>
<td>Inactive</td>
</tr>
</tbody>
</table>

**Table 3–2 Status Of Schedule - Schedules with Shipments**

<table>
<thead>
<tr>
<th>Code</th>
<th>Schedule Status</th>
<th>Status Type</th>
<th>NF Status in Shipment Process</th>
</tr>
</thead>
<tbody>
<tr>
<td>W</td>
<td>Worksheet</td>
<td>Inclusive</td>
<td>Worksheet</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Validated</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NFe Pending</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Request Approved</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Error</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Post Sefaz Approve Error</td>
</tr>
<tr>
<td>A</td>
<td>Approved</td>
<td>Exclusive</td>
<td>Approved</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Calculated</td>
</tr>
<tr>
<td>C</td>
<td>Completed</td>
<td>Exclusive</td>
<td>Completed</td>
</tr>
<tr>
<td>FP</td>
<td>Financials Posted</td>
<td>Exclusive</td>
<td>Financials Posted</td>
</tr>
</tbody>
</table>

**Status Type**

**Inclusive:**

It is considered status type Inclusive the status that does NOT depend on equivalence of status for all fiscal documents associated to the schedule.

Example, schedule status W: This status will accept NFs in different statuses, including status that associated to the next step in the process.

<table>
<thead>
<tr>
<th>Schedule</th>
<th>Schedule Status</th>
<th>NF</th>
<th>NF Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>90011</td>
<td>W</td>
<td>45001</td>
<td>Worksheet</td>
</tr>
<tr>
<td></td>
<td></td>
<td>45002</td>
<td>Validated</td>
</tr>
</tbody>
</table>
In the above example, one NF is in status W that belongs to the range of status accounted for schedule status W, but one NF was already validated and V status belongs to range of schedule status P.

Exclusive:

It is considered status type exclusive the status that depends on ALL fiscal documents to be in the same status of the range in order to be changed.

Example, schedule status P (Pending for Receiving): This status will changed only if ALL NFs have status V (Validated) or CL (Calculated).

<table>
<thead>
<tr>
<th>Schedule</th>
<th>Schedule Status</th>
<th>NF</th>
<th>NF Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>90011</td>
<td>P</td>
<td>45001</td>
<td>Validated</td>
</tr>
<tr>
<td></td>
<td></td>
<td>45002</td>
<td>Validated</td>
</tr>
</tbody>
</table>

In the above example, all NFs are in status V that belongs to the range of status accounted for schedule status P, hence schedule status will exclusively be P in this scenario.

- Enter the Start Date and the End Date in their respective fields.
- The Action Required field reflects either at schedule or fiscal document level. At least one of the fiscal documents in the schedules to be with the referenced status is required to select yes.

Example of a Schedule with two NFs in different status:

<table>
<thead>
<tr>
<th>Schedule</th>
<th>Schedule Status</th>
<th>Action Required</th>
<th>NF</th>
<th>NF Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>90011</td>
<td>R</td>
<td>Y</td>
<td>45001</td>
<td>Received</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>45002</td>
<td>Received</td>
</tr>
</tbody>
</table>

*RV status (Received Verified) would have no action required. However, R status (Received) needs action so Schedule Action Required Field will be Y.

Action required info mapping versus NF status and Schedule type:

<table>
<thead>
<tr>
<th>Action Required</th>
<th>Schedule Description</th>
<th>Schedule Receiving/Ship</th>
</tr>
</thead>
<tbody>
<tr>
<td>Y</td>
<td>Worksheet</td>
<td>Receiving/Ship</td>
</tr>
<tr>
<td>Y</td>
<td>In Discrepancy</td>
<td>Receiving</td>
</tr>
<tr>
<td>Y</td>
<td>Validated</td>
<td>Receiving/Ship</td>
</tr>
<tr>
<td>Y</td>
<td>Calculated</td>
<td>Receiving</td>
</tr>
<tr>
<td>N</td>
<td>NFe Pending</td>
<td>Shipment</td>
</tr>
<tr>
<td></td>
<td>Request Approved</td>
<td>Shipment</td>
</tr>
<tr>
<td>N</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Y</td>
<td>Error</td>
<td>Receiving/Ship</td>
</tr>
<tr>
<td>N</td>
<td>Verifying NF Status</td>
<td>Receiving</td>
</tr>
<tr>
<td>N</td>
<td>Submitted for Receiving</td>
<td>Receiving</td>
</tr>
</tbody>
</table>
5. Click Fiscal in the Receiving/Issue Schedule window. The Fiscal Docs Find window is displayed. This screen displays all the NFs linked to that schedule.

**Figure 3–3  Fiscal Docs Find Window**

<table>
<thead>
<tr>
<th>Action Required</th>
<th>Schedule Description</th>
<th>Schedule Receiving/Ship</th>
</tr>
</thead>
<tbody>
<tr>
<td>Y</td>
<td>Received</td>
<td>Receiving</td>
</tr>
<tr>
<td>N</td>
<td>Receipt Verified</td>
<td>Receiving</td>
</tr>
<tr>
<td>N</td>
<td>Manifest Pending</td>
<td>Receiving</td>
</tr>
<tr>
<td>Y</td>
<td>Post Sefaz Error</td>
<td>Receiving/Ship</td>
</tr>
<tr>
<td>N</td>
<td>Approved</td>
<td>Receiving/Ship</td>
</tr>
<tr>
<td>N</td>
<td>Completed</td>
<td>Receiving/Ship</td>
</tr>
<tr>
<td>N</td>
<td>Financial Posted</td>
<td>Receiving/Ship</td>
</tr>
<tr>
<td>N</td>
<td>Inactive</td>
<td>Receiving/Ship</td>
</tr>
<tr>
<td>N</td>
<td>Canceled</td>
<td>Shipment</td>
</tr>
<tr>
<td>N</td>
<td>Nullified</td>
<td>Shipment</td>
</tr>
<tr>
<td>N</td>
<td>Denied</td>
<td>Shipment</td>
</tr>
</tbody>
</table>

6. In the Fiscal Docs Find screen, click Add. The Fiscal Documents window is displayed.

The Fiscal Documents window is divided into three sections – Fiscal Document Header, Header Detail, and Line Item Level Detail.
In the Fiscal Document Header section, enter the details as given in table Table 3–3

**Table 3–3 Fields in the Fiscal Document Header Section**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requisition Type</td>
<td>Select Purchase Order Requisition Type for the PO receiving transaction from the drop-down list.</td>
</tr>
<tr>
<td>Utilization</td>
<td>This field is enabled only when the Requisition Type is entered. Select the Utilization from the list that is specific to the PO operation.</td>
</tr>
<tr>
<td>Entry CFOP</td>
<td>This field is populated by the tax integration. The Entry CFOP is used for the fiscal bookkeeping and Public System of Digital Bookkeeping or SPED. This field is non-editable. Note: SPED (Sistema Público de Escrituração Digital) is a digital file composed of a group of bookkeeping registers of fiscal documents and other information that the fiscal authorities of Brazilian government are interested in.</td>
</tr>
<tr>
<td>NF CFOP</td>
<td>Enter the value for NF CFOP. CFOP is the Operations and Service-Providing Fiscal Code.</td>
</tr>
<tr>
<td>Fiscal No</td>
<td>Enter the fiscal number. If the system option DI_NF_SERIAL_GENERATION_IND is Y for a DI NF, then this field and series number are not enabled. It is generated using the location sequencing functionality of ORFM.</td>
</tr>
</tbody>
</table>
### Status

Contains the possible status of the NF. When you are entering the details in the system, the status of NF is Worksheet. The NF has to be in Worksheet status to edit or cancel it. The other statuses are as follows:

- **In Discrepancy** – The application displays this status, when the NF is in the discrepant status. Discrepancies can be in quantity, cost, and tax.
- **Validated** – The NF status changes to Validated, if there are no data integrity errors.
- **Error** – The application displays this status for validation related errors, errors in NF generation using the EDI file, errors in NFe transmission or Tax Engine call for taxes.
- **Approved** – Post approval.
- **Received** – When the merchandise in the NF is received, the status of NF changes to Received.
- **Receipt Verified** – This status is displayed when the merchandise has been verified against the NF.
- **Completed** – This status is displayed when processing of the NF is completed.
- **NFe Pending** – This is applicable for NFe processing only. During the NFe issuing process, when the NFe has to be approved, the status of the NF is NFe Pending.
  
  PO NF of DI Import Type will also be submitted for SEFAZ approval from RFM if the indicator DI_NF_SERIAL_GENERATION_IND is Y.

  With the fiscal document in that status, the related information is sent to the fiscal partner solution which captures the data, generates the NFe file and submits it for approval in the Brazilian Governments systems.
- **Manifest Pending** – During the NFe including process, when the NFe has to be approved, the status of the NF is Manifest Pending.
- **Financials Posted** – This is applicable when the transaction details are entered in the transaction data table after NF approval.
- **Post Sefaz Approve Error** – This option is displayed when the NF is transmitted through the internet to the SEFAZ (Secretaria da Fazenda–Brazilian Tax Authority) of the origin state of the issuer.

  Inactive - Entry NF means Reject Entire Receiving from WMS/SIM' or 'entry NF was rejected'; Issue NF when NF was cancelled before get NF number.

- **Verifying NFe Status** - Waiting for validated by Sefaz.
- **Calculated** - Status used exclusively for Direct import scenario. Equivalent to Validated status, but without discrepancy verifications.
- **Denied** - When the NF is submitted for approval at SEFAZ but it gets rejected or Denied.

### Serial

Enter the serial number for the NF.

### Table 3–3 (Cont.) Fields in the Fiscal Document Header Section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Contains the possible status of the NF. When you are entering the details in the system, the status of NF is Worksheet. The NF has to be in Worksheet status to edit or cancel it. The other statuses are as follows:</td>
</tr>
<tr>
<td></td>
<td>- <strong>In Discrepancy</strong> – The application displays this status, when the NF is in the discrepant status. Discrepancies can be in quantity, cost, and tax.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Validated</strong> – The NF status changes to Validated, if there are no data integrity errors.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Error</strong> – The application displays this status for validation related errors, errors in NF generation using the EDI file, errors in NFe transmission or Tax Engine call for taxes.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Approved</strong> – Post approval.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Received</strong> – When the merchandise in the NF is received, the status of NF changes to Received.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Receipt Verified</strong> – This status is displayed when the merchandise has been verified against the NF.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Completed</strong> – This status is displayed when processing of the NF is completed.</td>
</tr>
<tr>
<td></td>
<td>- <strong>NFe Pending</strong> – This is applicable for NFe processing only. During the NFe issuing process, when the NFe has to be approved, the status of the NF is NFe Pending.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
  PO NF of DI Import Type will also be submitted for SEFAZ approval from RFM if the indicator DI_NF_SERIAL_GENERATION_IND is Y. With the fiscal document in that status, the related information is sent to the fiscal partner solution which captures the data, generates the NFe file and submits it for approval in the Brazilian Governments systems. |
|         | - **Manifest Pending** – During the NFe including process, when the NFe has to be approved, the status of the NF is Manifest Pending. |
|         | - **Financials Posted** – This is applicable when the transaction details are entered in the transaction data table after NF approval. |
|         | - **Post Sefaz Approve Error** – This option is displayed when the NF is transmitted through the internet to the SEFAZ (Secretaria da Fazenda–Brazilian Tax Authority) of the origin state of the issuer. |
|         |  
  Inactive - Entry NF means Reject Entire Receiving from WMS/SIM' or 'entry NF was rejected'; Issue NF when NF was cancelled before get NF number. |
|         | - **Verifying NFe Status** - Waiting for validated by Sefaz. |
|         | - **Calculated** - Status used exclusively for Direct import scenario. Equivalent to Validated status, but without discrepancy verifications. |
|         | - **Denied** - When the NF is submitted for approval at SEFAZ but it gets rejected or Denied. |
| Serial  | Enter the serial number for the NF. |
In the Header Details section, enter the following details – Header Info, Header Taxes, Additional Info, Transportation Details, Source Details, Destination Details, Importation Details, and Customer Details.

- Figure 3–5 shows the Header Info Tab and the fields and description are provided in Table 3–4.

Figure 3–5  Header Info Tab
Table 3–4  Fields in the Header Info Tab

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Totals</td>
<td>Informed and Calculated Service, Informed and Calculated Merchandise, and Informed and Calculated Total. Enter the details in each field. The Calculated Costs is obtained from the system.</td>
</tr>
<tr>
<td>Additional Costs</td>
<td>Freight, Insurance, Other Expenses, and Non Taxable Exp. When processing complementary NF for Freight, only these fields are enabled.</td>
</tr>
<tr>
<td>Discounts</td>
<td>Select Percentage or Value from the Type list. Enter the value in the Value field.</td>
</tr>
<tr>
<td>Discrepancy</td>
<td>Three check boxes, one each for Cost, Quantity and Tax are present. If the NF is in cost discrepancy, then the check box for Cost is selected. Likewise for Quantity and Tax.</td>
</tr>
<tr>
<td>Dates</td>
<td>Enter the Issue date, Entry/Exit date, Exit Hour of the NF, and Exchange Rate Date. Entry/Exit: The Entry/Exit date is updated to the date and time when the schedule is submitted to warehouse management system/store inventory management system for the physical receipt of merchandise. Exchange Rate Date: The Exchange Rate Date is introduced to support the multi currency functionality. For example, when you inform a PO NF for receiving, if the PO currency is different from NF currency, the exchange rate date keyed in will be considered for conversion into BRL on the NF. If left blank, the order approval will be considered.</td>
</tr>
<tr>
<td>Complement</td>
<td>Click Complement in the Header tab to link another NF (one that complements the main NF). In the ORFM application, the complement button is used for the following purposes: For triangulation, secondary NF coming from the Delivery Supplier, Freight or non-merchandise NF, Complementary NF for Cost/Tax Correction.</td>
</tr>
<tr>
<td>Req. Doc.</td>
<td>Click Req. Doc. to view all the all the POs for the given supplier. For more details, refer to Step 8.</td>
</tr>
</tbody>
</table>

**Note:** The Exchange Rate Date is a nullable field. For example, when informing PO NF values, if this field is null then the PO approval date is considered for all exchange rate calculations.

**Figure 3–6** shows the Header Taxes Tab and the fields and description are provided in Table 3–5.
Table 3–5  Fields in the Header Taxes Tab

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tax Code</td>
<td>The tax code that are part of the Brazilian tax system are present in the list. Select the tax code from the list.</td>
</tr>
<tr>
<td>Taxable Basis</td>
<td>Enter the taxable basis.</td>
</tr>
<tr>
<td>Modified Taxable Basis</td>
<td>This column displays the changed/modified taxable basis. This value flows from the external tax engine. In Brazil, some items are eligible to a tax rule that modifies the taxable basis. The tax rate for such items is applied on the modified taxable basis.</td>
</tr>
<tr>
<td>Total Tax Value</td>
<td>Enter the value. After entering the value for one tax code, click Add to enter additional details. In case, you want to delete any record, select the entry, and click Delete.</td>
</tr>
</tbody>
</table>

- Figure 3–7 shows the Additional Info Tab and the fields and description are provided in Table 3–6.

Table 3–6  Fields and Description of Additional Info Tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sender/Receiver</td>
<td>In this block, the following fields of the sender/receiver are auto populated: Address, City, Neighborhood, ZIP, State. These fields are taken from the Supplier/Supplier Site Address, City, and so on for a PO.</td>
</tr>
</tbody>
</table>
Table 3–7 Fields and Description of Transportation Details Tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>You can select any one of the Type from the list.</td>
</tr>
<tr>
<td></td>
<td>The Type list includes Bank, Agent, Freight Forwarder, Importer, Broker, Factory, Consolidator, Applicant, Consignee, Manufacturer, Expense Vendor, Import Authority, Escheat-State, Escheat-Country, Other, and External Finisher. Other Type is populated if the NF is a Free Form NF.</td>
</tr>
</tbody>
</table>
The following fields are enabled only for StandAlone NFs:

- Description
- State Inscription
- Tributary State
- Tributary Subscription No

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>This field is auto populated with the description of the Type selected.</td>
</tr>
<tr>
<td>State Inscription</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Tributary State</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Tributary Subscription No</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Vehicle Plate</td>
<td>This field is for SPED requirement.</td>
</tr>
<tr>
<td>Name</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Address</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>City</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Neighborhood</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Country</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Plate State</td>
<td>You can specify the field if the Entity in RMS check box is not selected. Else the field is dimmed.</td>
</tr>
<tr>
<td>CNPJ/CPF</td>
<td>Enter the CNPJ/CPF number. This field is free form entry if Entity in RMS is not selected.</td>
</tr>
<tr>
<td>Freight Type</td>
<td>You can either choose Cost Inclusive of Freight (CIF) and Free on Board (FOB) from the freight type list.</td>
</tr>
<tr>
<td>Qty</td>
<td>Enter the quantity of items.</td>
</tr>
<tr>
<td>UOM</td>
<td>Enter the unit of measure.</td>
</tr>
<tr>
<td>Net Weight</td>
<td>Enter the net weight.</td>
</tr>
<tr>
<td>Total Weight</td>
<td>Enter the total weight.</td>
</tr>
<tr>
<td>Entity in RMS</td>
<td>You have an option to deselect the Entity in RMS check box, for an NF having requisition type Free Form NF. For a Direct NF, the Entity in RMS check box is selected and dimmed.</td>
</tr>
</tbody>
</table>
- Neighborhood
- Country
- Entity in RMS

- Figure 3–9 shows the Importation Details Tab.

**Figure 3–9 Importation Details Tab**

![Image of Importation Details Tab]

The Importation Details tab is divided into three blocks – Customs, DI Details, and Parent NF.

**Table 3–8 Fields and Description of Importation Details Tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customs</td>
<td>In this block, enter the following fields:</td>
</tr>
<tr>
<td></td>
<td>- Customs Location</td>
</tr>
<tr>
<td></td>
<td>- Customs State - Select the Customs State from the list of states.</td>
</tr>
<tr>
<td></td>
<td>- Customs Date</td>
</tr>
<tr>
<td></td>
<td>- Incoterm - This is the type of transport with the following valid list of values to identify the transportation method used:</td>
</tr>
<tr>
<td></td>
<td>1 Maritime</td>
</tr>
<tr>
<td></td>
<td>2 River</td>
</tr>
<tr>
<td></td>
<td>3 Lake</td>
</tr>
<tr>
<td></td>
<td>4 Airlift</td>
</tr>
<tr>
<td></td>
<td>5 Post</td>
</tr>
<tr>
<td></td>
<td>6 Railroad</td>
</tr>
<tr>
<td></td>
<td>7 Road</td>
</tr>
<tr>
<td></td>
<td>8 Transmission network/Conduit</td>
</tr>
<tr>
<td></td>
<td>9 Own Means</td>
</tr>
<tr>
<td></td>
<td>10 Entry/Exit fictitious</td>
</tr>
<tr>
<td></td>
<td>AFRMM Value - This is the value paid to the Navy. This field is mandatory, if you choose Incoterm as the Maritime value.</td>
</tr>
<tr>
<td>DI Details</td>
<td>In this block, enter the DI Number, DI Issue Date, DI Type, Fiscal Authority ID, and Drawback Process. You can either choose Import Declaration or Simplified Import Declaration from the DI Type list.</td>
</tr>
</tbody>
</table>
In the Line Item Level Details section, the detailed information of the purchase order (PO) and the items are displayed.

You can populate the Detail Info section of PO in the following three ways:

- Default
- Custom
- UOM

Note: UOM view is available and editable only when NF is in Worksheet status.

- Click PO in the Detail Info tab of the Item Level Details section. Select the PO details from the list, or enter the PO details.

Figure 3–10 shows the Detail Info Tab and the fields and description are provided in Table 3–9.

---

**Table 3–9 Fields and Description of the Detail Info Tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PO</td>
<td>It is a requisition number.</td>
</tr>
<tr>
<td>Unexpected Item</td>
<td>Check this field if the item does not belong to any PO.</td>
</tr>
<tr>
<td>Item</td>
<td>Enter the item or items that are part of the purchase order.</td>
</tr>
<tr>
<td>Pack Ind</td>
<td>This indicator is highlighted if the item is a pack.</td>
</tr>
<tr>
<td>Unit</td>
<td>The number of units of the item.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Enter the quantity of the item.</td>
</tr>
<tr>
<td>Unit Cost</td>
<td>The unit cost of the item.</td>
</tr>
<tr>
<td>Discount Type</td>
<td>Enter the discount type applicable.</td>
</tr>
<tr>
<td>Discount</td>
<td>Enter the discount applicable.</td>
</tr>
<tr>
<td>Total Cost</td>
<td>Enter the total cost applicable.</td>
</tr>
</tbody>
</table>
**Note:** You can also view the Unit of Measurement (UOM) type by selecting UOM from the View menu.

Figure 3–11 shows the Detail Info UOM View and the fields and description are provided in Table 3–10.

**Figure 3–11  Detail Info UOM View**

![Detail Info UOM View](image)

**Table 3–10  Fields and Description of the Detail Info Tab UOM View**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PO</td>
<td>Enter the Purchase Order (PO) number.</td>
</tr>
<tr>
<td>Unexpected Item</td>
<td>Check this field if the item does not belong to any PO.</td>
</tr>
<tr>
<td>Item</td>
<td>Enter the item or items that are part of the purchase order.</td>
</tr>
<tr>
<td>Pack Ind</td>
<td>Enter the packet item indicator that are part of the purchase order.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter the description of the item.</td>
</tr>
<tr>
<td>NF Cfop</td>
<td>This field displays the CFOP code from Tax Engine.</td>
</tr>
<tr>
<td>UOM Type</td>
<td>UOM type provides an option to associate an appropriate NF based UOM to an item.</td>
</tr>
<tr>
<td></td>
<td>Select the UOM type from the following list:</td>
</tr>
<tr>
<td></td>
<td>- SUOM (refers to Standard Unit Of Measurement of the item)</td>
</tr>
<tr>
<td></td>
<td>- Case</td>
</tr>
<tr>
<td></td>
<td>- Pallet</td>
</tr>
<tr>
<td>Unit</td>
<td>The unit cost of the item.</td>
</tr>
<tr>
<td></td>
<td>Unit displays the corresponding SUOM if user selects UOM type as SUOM, Case, or Pallet.</td>
</tr>
<tr>
<td>Pack Size</td>
<td>Enter the pack size applicable.</td>
</tr>
<tr>
<td></td>
<td>You are not allowed to update the pack size during NF entry.</td>
</tr>
<tr>
<td>UOM Quantity</td>
<td>Enter the UOM quantity applicable.</td>
</tr>
<tr>
<td>UOM Unit Cost</td>
<td>Enter the UOM unit cost applicable.</td>
</tr>
<tr>
<td>Total Cost</td>
<td>Enter the total cost applicable.</td>
</tr>
</tbody>
</table>

**Note:** You cannot modify the Item or PO details in the default view that are modified in the UOM view.
Click the **Req. Doc.** button in the Header Details section. The Match Document window appears.

An example of the Match Document window is given below.

*Figure 3–12 Match Document Window*

In the Match Document window, all the open POs of that particular supplier are displayed.

To include the PO details in the NF, do the following:

- In the Additional Filter section of the Match Documents window, you can select POs from different supplier sites of the same supplier.

  Click **Add** in the Additional Filter section of the Match Documents window to view the POs from different supplier sites of that particular supplier in the multi-record block.

- Select one or more requisition documents from the list.

- Click **Add to NF.** The item level information from those POs is defaulted on the NF. This saves significant data entry efforts.

9. Select the check box for the **Unexpected Item** to indicate any unexpected item in the NF. When this check box is selected, the PO column is disabled and the value for the PO number is set to null.

Enter the item quantity and cost. The cost and the quantity of the unexpected item is not matched with the PO.

10. Click **Item.** Enter the items associated with the PO. If the PO contains pack items the **Pack Ind** check box is selected.
11. In the Detail Taxes tab, enter the tax details for the item.

**Table 3–11  Fields and Description of the Detail Taxes Tab**

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Indicates the type of tax such as ICMS, COFINS, and so on.</td>
</tr>
<tr>
<td>Tax Base</td>
<td>Indicates whether the tax is value-based or percentage-based.</td>
</tr>
<tr>
<td>Tax Basis</td>
<td>The basis for calculating the taxes.</td>
</tr>
<tr>
<td>Modified Tax Basis</td>
<td>Displays the modified or changed taxable basis. The external tax engine provides this basis, and this value is used for tax calculation. In Brazil, some items are eligible for a tax rule that modifies the taxable basis, mostly lower taxable basis. For such items, the tax rate is applied on the modified taxable basis. Tax Engine calculates the modified base and then calculates the tax values accordingly.</td>
</tr>
<tr>
<td>Tax Rate</td>
<td>The tax rate applied.</td>
</tr>
<tr>
<td>Total Value</td>
<td>The informed total value for the tax.</td>
</tr>
<tr>
<td>Legal Message</td>
<td>The legal message associated with the tax code at the line level.</td>
</tr>
</tbody>
</table>

**Note:** If you enter detail level taxes, you have to enter the detail level taxes for each item which are on the Item Detail grid. The Totals on the Detail Taxes tab has to match the Header tax information within the tolerance level.

See **Figure 3–13** for an example of the Detail Taxes tab.

**Figure 3–13  Detail Taxes Tab**

12. In the Additions tab, enter the additional details for the item.

**Table 3–12  Fields and Description of the Additions Tab**

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Po Number</td>
<td>Enter the purchase order number.</td>
</tr>
<tr>
<td>item</td>
<td>Enter the item or items that are part of the purchase order.</td>
</tr>
<tr>
<td>Pack Ind</td>
<td>This indicator is highlighted if the item is a pack.</td>
</tr>
<tr>
<td>Item Description</td>
<td>Enter the description of the item.</td>
</tr>
</tbody>
</table>
Table 3–12  (Cont.) Fields and Description of the Additions Tab

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additions Number</td>
<td>This field indicates the additions number.</td>
</tr>
<tr>
<td>Sequence Number</td>
<td>This field indicates the sequence number.</td>
</tr>
<tr>
<td>Foreign Manufacturer</td>
<td>This field indicates the foreign manufacturer code.</td>
</tr>
<tr>
<td>Additions Discount</td>
<td>This field indicates the additions discounts.</td>
</tr>
</tbody>
</table>

Note: Additions tab is enabled for Direct Import NF.

Figure 3–14 shows the Additions Tab and the fields and description are provided in Table 3–12.

Figure 3–14  Additions Tab

13. After you have entered the relevant details, from the Options menu, select Validate. If there is no discrepancy, the status of NF changes to Validated.

The different menu items of the Options menu in the Fiscal Documents window are given below.

Table 3–13  Options Menu Items and Description

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Worksheet</td>
<td>To edit the Nota Fiscal, change the status of NF to worksheet.</td>
</tr>
<tr>
<td>Validate</td>
<td>Use this option to validate the NF after entry. Validation process has the following steps involved:</td>
</tr>
<tr>
<td></td>
<td>■ Data Integrity Validation</td>
</tr>
<tr>
<td></td>
<td>■ Tax Engine Call for Tax Breakup</td>
</tr>
<tr>
<td></td>
<td>■ Discrepancy Identification</td>
</tr>
<tr>
<td></td>
<td>For more information, see Discrepancy Identification and Resolution Process.</td>
</tr>
<tr>
<td>Verify Received Qty</td>
<td>Use this option to review any discrepancy between the expected quantity as per the NF and the actual received quantity. This option is enabled for Inbound NFs only.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Use this option to cancel the NFs. ORFM allows cancellation for few types of NFs only, such as the NF for RMA.</td>
</tr>
<tr>
<td>Approve</td>
<td>Use this option to manually approve the NF. This is not applicable for inbound NFs.</td>
</tr>
</tbody>
</table>
14. Click **OK**. You are returned to the Fiscal Docs Find window.

15. Click **OK** in the Fiscal Docs Find window. You are returned to the Receiving/Issue Schedule window.

16. In the Receiving/Issue Schedule window, from the **Options** menu, select **Sub. for Recv**. The schedule is submitted for receiving.

   The different menu items on the Options menu in the Receiving/Issue Schedule window are as given below.

<table>
<thead>
<tr>
<th><strong>Table 3–13</strong> (Cont.) Options Menu Items and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Menu Item</strong></td>
</tr>
<tr>
<td>Print Correction Docs.</td>
</tr>
<tr>
<td>Error Log</td>
</tr>
<tr>
<td>Discrepancy Resolution</td>
</tr>
</tbody>
</table>

**Note:** The NFs in Submitted for Receiving status, and greater cannot be changed to Worksheet status for editing.

<table>
<thead>
<tr>
<th><strong>Table 3–14</strong> Options Menu Items and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Menu Items</strong></td>
</tr>
<tr>
<td>Worksheet</td>
</tr>
<tr>
<td>Validate</td>
</tr>
<tr>
<td>Sub. for Recv.</td>
</tr>
<tr>
<td>Print Rec. Report</td>
</tr>
<tr>
<td>Print Document</td>
</tr>
<tr>
<td>Approve</td>
</tr>
</tbody>
</table>
17. After the merchandise is received, ORFM uses the receipt updates, and the NF status is updated to Receipt Verified, if the received quantity is the same as the NF quantity. If there is a difference, the status changes to Received.

18. If the status is Received, from the Options menu in the Fiscal Documents windows, select Verify Received Qty. The Received Quantities window opens. Click Verify. The status changes to Receipt Verified, after reviewing the received quantity in this window.

19. After the receipt is verified, the NF status and schedule status changes to Approved. Upon approval, ORFM calculates the landed cost. The landed cost is determined by subtracting the recoverable taxes from the non-recoverable taxes and non-merchandise costs. The recoverable taxes includes ICMS, Programa de Integração Social (PIS), and Contribuição para Financiamento da Seguridade Social (COFINS). These three taxes are part of the unit cost. After removing the recoverable tax, add the nonrecoverable taxes like Imposto sobre Produtos Industrializados (IPI), and the non-merchandise cost (such as freight insurance).

20. ORFM then publishes the receipts with the updated landed cost to RMS.

### Viewing the Error Log

To view the error log, do the following:

**Navigate:** In the Receiving/Issue Schedule window, from the Options menu, select Error Log. The Error Log window appears.

**Note:** To view the error log at the NF level, in the Fiscal Documents window, from the Options menu, select Error Log.

### Table 3–14 (Cont.) Options Menu Items and Description

<table>
<thead>
<tr>
<th>Menu Items</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error Log</td>
<td>Select this option to see the Error Log associated with the schedule. For more information on Error log, see Viewing the Error Log.</td>
</tr>
</tbody>
</table>

---

In the filter section of the Error Log, you can enter any or all of the details as given in the following table:
Click the filter button after entering the values. The multi-record block displays the records that meet the filter criteria along with the Error Message.

3. Select the error and click **Fiscal Doc** to see the Fiscal Documents window.

4. Click **Close** to exit the window.

**NF Processing - Link and Delink**

The Receiving/Issuing module of ORFM enables you to link/delink an existing NF to a schedule.

---

**Note:** You can Link and Delink the NF on schedules of “Submitted for Receiving” status.

---

**Linking an NF to a Schedule**

To link the Nota Fiscal to a schedule, perform the following steps:

**Navigate:** From the RMS Start Menu, select **Fiscal Management**. In the Contents Of Fiscal Management, select Receiving/Issue. In the Contents Of **Receiving/Issue**, click **Edit**. The Receiving/Issue Schedule window appears.

1. Click **Fiscal** in the **Receiving/Issue Schedule** window. The Fiscal Docs Find window appears. This screen displays all the NFs linked to that schedule.

2. Click **Link** to link another NF to the schedule. The Fiscal Docs Find window appears.

3. Enter the query criteria in the Fiscal Docs Find window and execute the query. All NFs meeting the query criteria are displayed in the Fiscal Docs Find window.

---

**Note:** You can search for an item using fiscal number, or the VPN. See **Searching using Vendor Product Number in the Fiscal Docs Find window** for more information on searching for an Item using the VPN.

---

4. In the Fiscal Docs Find window, check the NF to be linked to the schedule, and click **OK**. The Fiscal Docs Find window displays the list of NFs linked to the schedule.
Note: Click OK + Repeat to add another NF to the schedule.

Figure 3–16  Fiscal Docs Find window - Linking an NF

5. Click Close to exit the window.

Delinking an NF and a Schedule
To delink the Nota Fiscal and the schedule, perform the following steps:


1. Click Fiscal in the Receiving/Issue Schedule window. The Fiscal Docs Find window appears. This screen displays all the NFs linked to that schedule.

2. Select the NF, and click Delink to delink the NF from the schedule. The following message is displayed:

Figure 3–17  Delinking an NF

3. Click Yes to delink the NF.

4. Click Close to exit the window. You are returned to the Receiving/Issue Schedule window.

Discrepancy Resolution
The NF processing for PO Receiving described in the section — NF Processing - PO Receiving works when there is no discrepancy. When there is a difference between the NF cost and PO Cost or NF quantity and PO Quantity, or NF tax and tax details from Tax Engine, the NF is said to be discrepant or in the In Discrepancy status.
The two approaches that are supported in ORFM for the resolution of discrepancies are as follows:

- **Centralized Discrepancy Resolution** – In the centralized discrepancy resolution process, the quantity discrepancies identified during the discrepancy identification has to be resolved before submitting the NF for receiving. The quantity discrepancy can be resolved at the receiving location or at the centralized location. However, the cost and tax discrepancy can be resolved at the central location after the physical receipt of the merchandise. The centralized location may refer to company headquarter or the regional office.

The status of NF or schedule in centralized receiving flow is as follows:

<table>
<thead>
<tr>
<th>Quantity Discrepancy</th>
<th>Cost Discrepancy</th>
<th>Tax Discrepancy</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>In Discrepancy</td>
</tr>
<tr>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>In Discrepancy</td>
</tr>
<tr>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>In Discrepancy</td>
</tr>
<tr>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Validated</td>
</tr>
<tr>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Validated</td>
</tr>
<tr>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>In Discrepancy</td>
</tr>
</tbody>
</table>

The NF status will not change to Approved unless all the discrepancies are resolved.

In addition, the Discrepancy Resolution item on the Options menu in the Fiscal Documents window is enabled till all the discrepancies are resolved. The check box in the Discrepancy section of the Header Details section is selected for the unresolved discrepancy.

- **De-centralized Discrepancy Resolution** – In the de-centralized discrepancy resolution approach, all the discrepancies are resolved at the location where the merchandise is to be received. The receiving location may be a warehouse or store.

In this approach, the NF status is set to In Discrepancy if any discrepancy exists after validation.

You cannot submit the NF for receiving until all the discrepancies are resolved, and hence physical receiving before discrepancy resolution is not possible. Only after all the discrepancies are resolved, will the NF status change to Validated, and you can submit the NF for receiving.

**User Interface Indicators for Discrepancy**

The Fiscal Docs Find displays the status of NF as In Discrepancy as shown below:
If there is quantity, cost or tax discrepancy, the Fiscal Documents window displays the status of NF as **In Discrepancy**.

In the Header area of the Fiscal Documents window, the check box is selected for the discrepancy that is present on the NF as shown in Figure 3–20.

**Centralized Resolution Discrepancy Process**

In the centralized discrepancy resolution process, the quantity discrepancy is resolved at the receiving location or at the centralized location. The cost and tax discrepancies may not be resolved, but the nota fiscal will be in Validated status. The process to resolve quantity discrepancy is given below.

**Quantity Discrepancy**

In order to resolve quantity discrepancy, do the following:

1. From the **Options** menu in the Fiscal Documents window, select **Discrepancy Resolution**. The Discrepancy Resolution window appears.
As highlighted in Figure 3–21, the check box for Qty is selected to indicate quantity discrepancy.

**Note:** It is not necessary for the all the discrepancies to exist together.

2. Click **Resolve Qty** in the Discrepancy Resolution window to resolve only quantity discrepancy. The Discrepancy Resolution window displays the quantity details.

**Figure 3–22 Discrepancy Resolution (Quantity)**

3. In the Discrepancy Resolution window, the list in the Resolution Action field has two options – System or Nota Fiscal. Select one of the options. Click **Resolve Disc**.

**Note:** Depending on the system options set, ORFM decides the action to be taken for discrepancy resolution.

For example, in case the system option is set to System, the Nota Fiscal option is disabled. You have to select System to resolve the discrepancy.
4. The message – "Selected Resolution Action will be applied to all the discrepant records. Are you sure you want to continue?" is displayed. Click Yes. You are returned to the Discrepancy Resolution window. Notice that the check box for quantity is not selected, and the Resolve Qty button is disabled as highlighted in Figure 3–23.

![Discrepancy Resolution with Resolved Quantity](image)

**Figure 3–23 Discrepancy Resolution with Resolved Quantity**

5. Click OK. You are returned to the Fiscal Documents window. The status of the Nota Fiscal is changed to Validated, if no other discrepancies exist.

6. In the Receiving/Issue Schedule window, from the Options menu, select Sub. for Recv.

7. The status of schedule changes from Validated to Subm. for Recv.

8. After the items are received, the status of the nota fiscal changes to Received.

9. Since there is a quantity discrepancy, you have to review the received quantities, before the nota fiscal can be approved. From the Options menu, select Verify Received Qty. The Received Quantities window appears.

![Received Quantities Window](image)

**Figure 3–24 Received Quantities Window**
10. In the Received Quantities window, click Verify.

In this window, review the quantity of merchandise received. After reviewing the quantity of merchandise received, the status of the NF changes to Approved if there are no pending discrepancies to be resolved.

11. A correction document is generated, depending on what you have selected while resolving the quantity.

**Return NF and Merchandise without NF Report Generation**

Return NF and Merchandise without NF report can be generated at every NF level in the schedule. These reports are generated only if there is any return NF quantity or merchandise without NF quantity for any item on the NF.

The Return NF is sent to the supplier for the extra or damaged quantities. The cost and the tax details for the quantity of merchandise to be returned to the supplier are calculated.

To generate merchandise without NF, do the following:

1. In the Fiscal Documents window, from the Options menu, select Print Correction Docs. The Correction Documents List window opens.

**Figure 3–25 Correction Documents List Window**

The Correction Documents grid section lists all the correction document types that can be generated for the NF. The list may include the following, and depends on the corrective action taken:

- **Return NF** – To return the stock to the supplier that was either received in excess or was damaged and hence rejected by warehouse management system or store inventory management system, a Return NF is generated.

  After excess or damaged receiving, if system generates Return NF report, system also auto generates Return NF in Exit mode with the reference number of main NF.

- **Merchandise without NF** – If any item is received without mention on the NF, it is listed in the merchandise without NF report. This is an internal report that need not be sent to the supplier. Any such inventory is handled outside the system. The inventory featuring in this report is not accounted as on-hand inventory.

- **Discrepancy Report** – This document is generated when there are discrepancies. You can send the discrepancy report to correct the cost, quantity and tax discrepancies.
Discrepancy Resolution

- Complementary NF Request – This document is generated when the supplier has incorrectly charged lower taxes than system calculated taxes. Print this document and send it to the supplier requesting the complementary NF with corrected taxes.

2. To print the document, select the check box for merchandise without NF.

3. Click Print. The merchandise without NF is printed.

De-centralized Discrepancy Resolution Process

In the de-centralized discrepancy resolution approach, all the discrepancies are resolved at the location where the merchandise is to be received. The receiving location may be a warehouse or store.

The cost and tax discrepancy resolution processes are described below.

**Note:** To know more about resolving quantity discrepancy, refer to Quantity Discrepancy.

**Cost Discrepancy**

In order to resolve cost discrepancy, do the following:

1. From the Options menu in the Fiscal Documents window, select Discrepancy Resolution. The Discrepancy Resolution window is displayed.

2. As shown in Figure 3–26, if there is cost, and tax discrepancy, the check boxes for Cost, and Tax are selected.

3. Click Resolve Cost in the Discrepancy Resolution window to resolve the discrepancy in cost.

4. The Discrepancy Resolution window displays the cost details. In this window, the list in the Resolution Action field has two options – System or Nota Fiscal. Select one of the options. Click Resolve Disc.
4. The message – "Selected Resolution Action will be applied to all the discrepant records. Are you sure you want to continue?" is displayed. Click Yes. You are returned to the Discrepancy Resolution window. Notice that the check box for Cost is not selected, and the Resolve Cost button is disabled as highlighted in Figure 3–28.

5. Click OK. You are returned to the Fiscal Documents window. The status of the NF changes to Validated.

6. Click Close. You are returned to the Receiving/Issue Schedule window. From the Options menu, select Sub. for Recv.

7. After the items are received, the status of the nota fiscal changes to Received, if there are any overages/damages and under-receiving. Else, the status of NF changes to Approved.

**Printing Correction Documents**

If the System Option is set to System, then a correction document is generated whenever a discrepancy occurs. The NF has to be in Approved status.
1. From the Options menu in the Fiscal Documents window, select Print Correction Docs. The Corrections Document List is displayed.

**Note:** The Print Correction Docs option is enabled only for approved NFs.

**Figure 3–29  Corrections Document List Window**

2. Select the check box for Discrepancy Report.
3. Click Print. The correction document for the cost discrepancy is printed.

**Tax Discrepancy**

In order to resolve tax discrepancy, do the following:

1. From the Options menu, select Discrepancy Resolution. The Discrepancy Resolution window is displayed.

**Figure 3–30  Discrepancy Resolution window with Tax Discrepancy**

2. Click Resolve Tax in the Discrepancy Resolution window. The system and informed tax are displayed in the Discrepancy Resolution window.

The system tax includes:

- Base Value – The basis for calculation of the tax
■ Modified Base Value – Contains the taxable basis changed by external tax engine for tax calculation. This happens when a tax rule modifies the taxable basis, mostly in the form of a lower taxable basis. It reflects the taxable basis the tax rate is actually applied on by external tax engine.

■ Value – The total value

The informed tax includes

■ Base Value – Informed calculated basis for the tax

■ Modified Base Value – The changed basis, which flows from the external tax engine. This value is applicable for only certain items that are eligible for a tax rule, which modifies the basis on which the tax rate is calculated.

■ Value – The informed total value for the tax

Figure 3–31  Tax Discrepancy Window

3. In this Discrepancy Resolution window, click Item Details. The Item Tax Details is displayed in the Discrepancy Resolution window.

Figure 3–32  Item Tax Details Window

Table 3–17  Item Tax Details Fields and Description

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tax Code</td>
<td>The tax code returned by the external tax engine</td>
</tr>
</tbody>
</table>
Table 3–17 (Cont.) Item Tax Details Fields and Description

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Taxable Base Value</td>
<td>The total basis on which the tax is calculated</td>
</tr>
<tr>
<td>System Tax Value</td>
<td>The total tax value returned calculated by the tax engine</td>
</tr>
<tr>
<td>Informed Taxable Base Value on NF</td>
<td>The total taxable basis apportioned to the line level by the application</td>
</tr>
<tr>
<td>Informed Tax Value on NF</td>
<td>The total taxable value apportioned to the line level by the application</td>
</tr>
</tbody>
</table>

Item Tax Details Section

<table>
<thead>
<tr>
<th>Item</th>
<th>The merchandise number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order No</td>
<td>The purchase order number</td>
</tr>
<tr>
<td>Base Value</td>
<td>System Tax – The basis used while calculating the tax</td>
</tr>
<tr>
<td></td>
<td>Apportioned Tax on NF – The apportioned tax basis value calculated for the fiscal line using the header tax basis values</td>
</tr>
<tr>
<td>Modified Base Value</td>
<td>System Tax – Modified Base Value is applicable to items that are eligible to a tax rule that modifies the taxable basis</td>
</tr>
<tr>
<td></td>
<td>Apportioned Tax on NF – Modified apportioned tax basis value calculated for the fiscal line using the modified header tax basis values</td>
</tr>
<tr>
<td>Rate</td>
<td>System Tax – The tax rate at the item level</td>
</tr>
<tr>
<td></td>
<td>Apportioned Tax on NF – The apportioned tax rate calculated at the fiscal line level</td>
</tr>
<tr>
<td>Value</td>
<td>System Tax – The system tax value of the individual item</td>
</tr>
<tr>
<td></td>
<td>Apportioned Tax on NF – The apportioned tax value calculated for the fiscal line using the header tax value</td>
</tr>
<tr>
<td>Value/Unit</td>
<td>System Tax – The unit tax amount calculated</td>
</tr>
<tr>
<td></td>
<td>Apportioned Tax on NF – The apportioned unit tax amount</td>
</tr>
<tr>
<td>Resolution By</td>
<td>The resolution can be either as per the System or as per the Nota Fiscal</td>
</tr>
<tr>
<td>Reason</td>
<td>The reason for the resolution action (optional)</td>
</tr>
</tbody>
</table>

4. In the Resolution By field, click the list, and select from resolve by either System or Nota Fiscal. Click **Resolve Disc**.

**Note:** Depending on the system options set, ORFM decides the action to be taken for discrepancy resolution.

For example, in case the system option is set to System, the Nota Fiscal option is disabled. The list for resolution is disabled and default method of resolution is set as ‘System’.

5. The message – "Selected Resolution Action will be applied to all the discrepant records. Are you sure you want to continue?" is displayed. Click **Yes**. You are returned to the Discrepancy Resolution window. Click **Close**.
Complementary NF

In the Discrepancy Resolution window, notice that the check box for Tax is not selected, and the Resolve Tax button is disabled as highlighted in Figure 3–33. The Status of the Nota Fiscal is changed to Validated.

Figure 3–33 Discrepancy Resolution Window

6. Click Close in the Discrepancy Resolution window. You are returned to the Fiscal Documents window. The status of the NF is changed to Validated.

7. Click OK in the Fiscal Documents window. The Fiscal Docs Find window appears. The status of the NF is displayed as Validated.

8. Click Close in the Fiscal Docs Find window. The Receiving/Issue Schedule window appears. From the Options menu, select Sub. for Recv.

9. After the items are received, the status of the nota fiscal changes to Received, if there are any overages/damages and under-receiving. Else, the status of NF changes to Approved.

10. After the NF is approved, a correction document or complementary NF for tax is generated, based on what you have selected while resolving the discrepancies.

Complementary NF

In the following scenarios, the supplier may issue an additional (complementary) NF in addition to the regular NF:

■ Triangulation Purchase (additional NF from Delivery Supplier)
■ Non-merchandise cost charged by a different supplier that is, partner (non-merchandise NF)
■ NF for Cost Correction
■ NF for Tax Correction

Note: If more than one component of the tax is in discrepant state, then the Discrepancy Resolution window displays the details of all the tax components. Follow the procedure listed in steps three to five to resolve the tax discrepancy.

In the Discrepancy Resolution window, notice that the check box for Tax is not selected, and the Resolve Tax button is disabled as highlighted in Figure 3–33. The Status of the Nota Fiscal is changed to Validated.
The complementary NF may impact the total amount payable and also the landed cost (and hence the WAC) of the item.

The utilization attributes is set up to one of the below values to differentiate the type of Complementary NF:

- Triangulation
- Non-Merchandise cost
- Cost/Tax Correction

For more information on the set up, see Fiscal Utilization Attributes Window.

Complementary NF for Triangulation

While creating the purchase order, the user can mention a supplier (referred to as the main supplier) to whom the payment is made and another supplier (a distributor or facilitator) who actually delivers the stock on behalf of the main supplier (referred to as the delivery supplier). This mechanism is referred to as the triangulation purchase.

The main supplier and the delivery supplier may be located in different states. In such cases, the state level taxes like ICMS and ICMS-ST are calculated based on the location of the delivery supplier.

In triangulation purchases, the retailer receives two NFs for the same inventory. One from the main supplier, which primarily serves as an invoice for making the payment and another from the delivery supplier, which serves as a bill of lading document. This document is referred to as the complementary NF for triangulation. Since ICMS and ICMS-ST depend on the delivery supplier's location, they appear on the delivery supplier's NF.

Complementary NF Processing for Triangulation

To create a complementary NF for triangulation, do the following:

**Note:** The retailer has to create a purchase order, and label it as triangulation.

---

**Navigate:** From the RMS Start Menu, select Fiscal Management, then select Contents Of Fiscal Management.

1. In Contents Of Fiscal Management, select Login of Location. The Location Login window appears.

2. In the Location Login window, select the store or warehouse of the main supplier. Click the Location LOV to obtain the list of stores or warehouses. Select the location and click OK.


4. In the Receiving/Issue Schedule window, click Add. A new NF is created in the Entry mode.

5. Click Fiscal in the Receiving/Issue Schedule window. The Fiscal Docs Find window appears.

6. Click Add in the Fiscal Docs Find window. The Fiscal Documents window appears. Enter the Utilization code for triangulation.
Complementary NF for Non-Merchandise Cost

7. Enter the other values in the Fiscal Documents window. The NF is created in the **Worksheet** status.

8. Click OK. You are returned to the Fiscal Docs Find window. The Fiscal Docs Find window displays the NF that is created in the worksheet status.

9. Create another NF using the same process as given above. This is the complementary NF, and it has to be in the same schedule as the main NF. It should have the same item details as the main NF.

10. After creating another NF, return to the Fiscal Docs Find window, and select the first NF created for the main supplier.


12. In the Complement No column, select the complementary NF. Click **Add** to link this NF with the main NF.

13. Click OK to return to the main NF. From the **Options** menu, select **Validate**. The status of NF changes to **Validated**, if there is no discrepancy between the two NFs. You are returned to the Receiving/Issue Schedule window.

**Note:** The data integrity validation has to display an error if either of the NF is not entered in the application.

14. In the Receiving/Issue Schedule window, select the NF and submit it for receiving. From the **Options** menu, select **Sub. for Recv**.

**Complementary NF for Non-Merchandise Cost**

Complementary NF for non-merchandise cost is generated to account for the freight charges incurred during transportation of merchandise. The non-merchandise cost refers to Freight Cost, Insurance Cost, and Other Expenses. Non-merchandise cost is
Complementary NF for Non-Merchandise Cost

charged by a different supplier (or partner). In such cases, the supplier has to issue an additional NF or complementary NF in addition to the regular NF.

In Complementary NF for non-merchandise cost, NFs can have multiple main NFs or none. Once the main NFs are associated to the Complementary NF for non-merchandise cost NF, the cost components are apportioned to the items that are present in the main NF.

**Complementary NF Processing for Non-Merchandise Cost**

To do the NF Processing for non-merchandise cost, do the following:

**Navigate:** From the RMS Start Menu, select Fiscal Management, then select Login of Location. The Location Login window is displayed.

1. Select the location from the Location LOV in the Location Login window.
2. Click OK to exit the window.
3. From the RMS Start Menu, select Receiving/Issue. In the Contents Of Receiving/Issue, click Edit. The Receiving/Issue Schedule window is displayed.
4. Click Add in the Receiving/Issue Schedule window.
   A new schedule is created.

**Note:** You can link the Complementary NF for Non-Merchandise Cost to a schedule. The Complementary NF for Non-Merchandise Cost can remain without a schedule.

Multiple main NFs can be attached to one Complementary NF for Non-Merchandise Cost. However, you cannot associate the Complementary NF to any main NFs.

5. Select the new schedule and click Fiscal in the Receiving/Issue Schedule window. The Fiscal Docs Find window is displayed.
6. In the Fiscal Docs Find window, click Add.
   The Fiscal Documents window is displayed.
7. In the Fiscal Documents window, select Purchase Order as the Requisition Type from the list.
8. In the Utilization field, set the Utilization field for both Comp NF for Merchandise and Non-Merchandise.
   After you enter the Utilization as **Comp NF for Merchandise and Non-Merchandise**, in the Header Details of the Fiscal Documents window, the Service and Merchandise Cost fields are disabled. Requisition Doc button is disabled.
   The Additional Costs fields that include Freight, Insurance, and Other Expenses are enabled. In the Line Item Detail section, the fields in the Detail Info tab and Detail Taxes tab are disabled.
9. Enter the expenses incurred for freight and insurance in their respective fields. If other expenses are present, enter the details in the Other Expenses field.
   The Totals in the Header Details section is also enabled.
10. Click Complement to associate this NF with the main NF.
11. In the Fiscal Documents window, from the Options menu, click Validate. During the validation process, the total cost is validated. After the validation, status automatically changes to Approved.

**Complementary NF for Cost/Tax Correction**

Complementary NF for Cost/Tax is generated by the Supplier when there is additional costs to be paid by the Retailer because of some discrepancies in the original NF generated for the Purchase Order.

There can be multiple complementary NFs for cost and tax correction that correspond to one main NF. But one complementary NF cannot correspond to more than one main NF. In case of cost and tax discrepancy in one main NF, the supplier may send one complementary NF for cost correction and one complementary NF for each tax code correction; or the Supplier may send single complementary NF for the correction of cost and all the taxes.

The complementary NF for cost and tax will result in updating the cost in RMS.

**Complementary NF Processing for Cost/Tax Correction**

To do the NF Processing for cost/tax correction do the following:

**Navigate:** From the RMS Start Menu, select Fiscal Management, then select Login of Location. The Location Login window is displayed.

1. Select the location from the Location LOV in the Location Login window. Click OK to exit the window.
2. From the RMS Start Menu, select Receiving/Issue. In the Contents Of Receiving/Issue, click Edit.
   
   The Receiving/Issue Schedule window is displayed.
3. Click Add in the Receiving/Issue Schedule window.
   
   A new schedule is created.

**Note:** You can associate only one main NF to a Complementary NF for Cost/Tax Correction.

4. Select the new schedule and click Fiscal in the Receiving/Issue Schedule window. The Fiscal Docs Find window is displayed.
5. In the Fiscal Docs Find window, click Add. The Fiscal Documents window is displayed.
6. In the Fiscal Documents window, select Purchase Order as the Requisition Type from the list.
7. In the Utilization field, set the Utilization to Comp NF for Cost/Tax Correction.
   
   After you enter the Utilization as Comp NF for Cost/Tax Correction, in the Header Details of the Fiscal Documents window, the Service and Merchandise Cost fields are disabled. Requisition Doc button is disabled.

   The Additional Costs fields that include Freight, Insurance, and Other Expenses are enabled. In the Line Item Detail section, the fields in the Detail Info tab and Detail Taxes tab are disabled.
8. Enter the expenses incurred for freight and insurance in their respective fields. If other expenses are present, enter the details in the **Other Expenses** field.

   The **Totals** in the Header Details section is also enabled.

9. Click **Complete** to associate this NF with the main NF.

10. In the Fiscal Documents window, from the **Options** menu, click **Validate**.

   During the validation process, the total cost is validated. After the validation, status automatically changes to **Approved**.

---

**Deal Income Posting**

ORFM takes care of posting all finance related documents (NFs) for merchandise inventory/goods movement and finance invoicing. For Deal Income, though there is no inventory/goods movement, financial documents are generated to post the deal income to finance.

You need to define the default utilization in ORFM system options for deal NF. The Deal NF Utilization should be of requisition type PO.

Deal NFs are auto-generated and are not editable through ORFM User Interface. You can view the NF and print it if needed.

**Deal Types**

RMS supports the following three types of deals:

- Off-Invoice
- Fixed (Merchandise and Non-merchandise)
- Complex

RMS generates the following two types of fixed deal:

- Fixed deal with Merchandise and location information associated
- Fixed deal non-merchandise with no location and merchandise information associated

RMS deal batches generate the deal income on fixed deals in RMS staging tables, based on the income calculation and invoicing frequency.

For non-merchandise fixed deals, ORFM will always generate NF details at the Set Of Books (SOB) level.

A Complex Deal is created and approved in RMS with a Deal Income calculation frequency and an invoicing frequency. Once the Deal Income calculation frequency is met, RMS calculates the Deal Income through deal batches and stores them in Deal Income related tables. Once the invoicing frequency period for the deal is reached, RMS deal batches make this information available in the RMS staging tables to be processed by ORFM.

For a deal income processing that happens in RMS, a deal NF (approved status) is generated in ORFM after running the 'fmdealinc' batch.

For more information on Deal Income Batch Processing, see *Oracle Retail Fiscal Management/RMS Brazil Localization Implementation Guide*. 
The Return to Vendor (RTV) operation is considered as the cancellation of the original purchase from a fiscal stand point. In order to revert a purchase operation it is necessary to associate the RTV NF to the original PO NF that is being returned. Costs and taxes from the referenced PONF are taken and proportionally used in the RTV NF in order to revert the transaction in all necessary aspects.

It is part of Brazilian legislation, the control of the quantities returned regarding the original purchase NFs associated. A balance control is necessary to avoid scenarios where same PONF is referenced to multiple RTV NFs exceeding the quantity returned in comparison with the quantity purchase.

To initiate the RTV flow in ORFM, the inventory that has to be returned is picked and shipped in warehouse management system and store inventory management system.

After the RTV shipment details are available in the ORFM application, it generates an outbound schedule and NF.

This chapter contains the following:

- **Business Flow**

**Business Flow**

The process is similar for both the RTV from a store or RTV from a warehouse. The business process can include the following:

- Create an outbound NF from the shipment details. This is automatic step.
- Enable the auto-approve parameter of the utilization code to validate and approve the NF immediately.
- For manual validation, and approval process, disable the auto-approve parameter of the utilization code. Manually edit the NF to resolve the errors that occur during the validation process. Here, the validation process includes sending the NF to Tax Engine for CFOP determination. For each item being returned, the system selects the last received PO related NF for that item from the same supplier as the reference NF for the RTV NF. If the last reference NF is found, the taxes on RTV NF are copied from that NF. If the last reference NF is not found, the Tax Engine call returns the taxes applicable on the RTV transaction.
- In utilization code, the parameter ‘choose NF’ enables users to manually select the referenced NF for each line.
- The new system option, BALANCE_CONTROL_RTV can be used to enable/disable the quantity balance control in ORFM. Once enabled, the process of automatic or manual reference NF selection will take into consideration the
quantities received and returned in order to determine which PONF will be taken as reference for the RTV.

- During NF approval, it is interfaced to NFe integration that will have the NFe approved in governments system. NF will be turned to status Approved and the inventory is updated in RMS.

**NF Processing for RTV with Balance Control Disabled**

To create a NF for RTV, do the following:

**Navigate:** From the RMS Start Menu, select Fiscal Management, then Login of Location. The Location Login window appears.

1. In the Location Login window, select the store or warehouse for receiving/issuing of the fiscal document. Click the Location LOV to obtain the list of stores or warehouses. Select the location, and click OK.


**Figure 4–1 Schedule Window**

3. In the Receiving/Issue Schedule window, set the Mode as Exit. A list of schedules will be displayed accordingly to the pre-defined filters. If the schedule you are looking for is not displayed, use different filters.


**Figure 4–2 Fiscal Docs Find Window**

5. Click Detail. The Fiscal Documents window appears.
In the Fiscal Documents window, the details of the shipment that is created in warehouse management system, and that flows to ORFM are displayed.

In the Fiscal Documents window, the fields that are specific to RTV are covered below.

**Table 4–1 Differences in values for RTV on the Fiscal Documents window**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Fiscal Document section</strong></td>
<td></td>
</tr>
<tr>
<td>Requisition Type</td>
<td>This field displays Return to Vendor.</td>
</tr>
<tr>
<td>Utilization</td>
<td>This field displays the utilization code configured for RTV.</td>
</tr>
<tr>
<td>Document Type</td>
<td>This field displays the document type configured for RTV.</td>
</tr>
<tr>
<td>Mode Type</td>
<td>Exit</td>
</tr>
<tr>
<td><strong>Header Details section</strong></td>
<td></td>
</tr>
<tr>
<td>Transportation Details Tab</td>
<td>The Type list displays External Finisher.</td>
</tr>
<tr>
<td><strong>Line Item Details section</strong></td>
<td></td>
</tr>
<tr>
<td>Detail Info Tab</td>
<td>RTV details are displayed in the RTV secondary tab.</td>
</tr>
</tbody>
</table>

6. If the reference NF for RTV NF issues is set to 'Yes', it is mandatory to inform the reference NF for RTV. The Fiscal Doc Ref field will bring a reference NF number automatically associated to the RTV being generated. If no reference is there, it was not possible to find any PONF to associate and being the reference NF mandatory, you will not be able to approve this NF.

7. If the Auto Approve parameter for the utilization code is set to 'Yes', the NF will likely be issued in NFe Pending status or directly in Approved status if the integration with NFe is already completed.

8. If the Auto Approve parameter for the utilization code is set to 'NO', the NF will be in Worksheet status and user has to validate and approve it. From the Options menu in the Fiscal Documents window, select Validate. If there are no errors, the status of NF changes to Validated.

The NF will be in Error status, if errors occur during the validation process. You have to manually edit the NF to resolve validation errors.

9. From the Options menu in the Fiscal Documents window, select Approve. RTV NF will be changed to status NFe Pending until NFe integration is processed.
Once that happens, NF will be changed to status Approved. The schedule will be changed to status Approved as well. Once NF is approved, inventory is updated in RMS.

---

**Note:** Based on the NF-e line limit set and the item having the grouping attribute flagged or not (ST break out), the shipment is broken into multiple NFs in ORFM.

---

**NF Processing for RTV with Balance Control Enabled**

To create a NF for RTV, do the following:

**Navigate:** From the RMS Start Menu, select Fiscal Management, then Login of Location. The Location Login window appears.

1. In the Location Login window, select the store or warehouse for receiving/issuing of the fiscal document. Click the Location LOV to obtain the list of stores or warehouses. Select the location, and click **OK**.

2. In Contents Of Fiscal Management, click Receiving/Issue. In Contents Of Receiving/Issue, click **Edit**. The Receiving/Issue Schedule window appears. In the Receiving/Issue Schedule window, set the Mode as Exit. A list of schedules will be displayed accordingly to the pre-defined filters. If the schedule you are looking for is not displayed, use different filters.

3. Click **Fiscal** in the Receiving/Issue Schedule window. The Fiscal Docs Find window appears.

4. Click **Detail**. The Fiscal Documents window appears. In the Fiscal Documents window, the details of the shipment that is created in warehouse management system, and that flows to ORFM are displayed.

5. If the reference NF for RTV NF issues is set to 'Yes', it is mandatory to inform the reference NF for RTV. The Fiscal Doc Ref field will bring a reference NF number automatically associated to the RTV being generated. If no reference is there, it was not possible to find any PONF to associate and being the reference NF mandatory, user will not be able to approve this NF.

6. If the Auto Approve parameter for the utilization code is set to 'YES' the NF will likely be issued in NFe Pending status or directly in Approved status if the integration with NFe is already completed. In this case, and considering the Balance Control enabled, there will be at least one reference NF number associated to each item of the NF. It is also possible that more than one reference NF got associated to the same line item, depending on the balance of quantities available in each reference NF versus the quantity being returned.

7. If the Auto Approve parameter for the utilization code is set to 'NO', the NF will be in Worksheet status and you have to validate and approve it. You can also manually select the reference NF for each item. This is possible through a new popup window created for balance control.
By clicking the Fiscal Doc Ref button, you will see a working popup window where you can manage the Reference NF selection process. This window will list all PONFs available to be selected as reference. You can also break the selection having multiple NFs being selected based on the quantity returned and the balance available in each NF.

Note: The PO NFs available in this popup window are the ones that were received and approved for the item in the location that is creating the RTV. Only purchase order related NFs will be displayed in this list. It is also possible that Triangulation related NFs appear. Users will be able to select triangulation PO NFs, but in this case 100% of the item quantity must be linked to a triangulation NF and all other items in the RTV must belong to same triangulation NF as well. No mix and match will be allowed between Triangulation and Regular PO NFs for the reference field.

Once the reference NF selection is complete, you can view the reference NFs for each item in the new tab in Fiscal Documents window.
10. With all items associated to a reference NF, you can validate the RTV NF. From the Options menu in the Fiscal Documents window, select **Validate**. If there are no errors, the status of NF changes to **Validated**.

   The NF will be in **Error** status, if errors occur during the validation process. You have to manually edit the NF to resolve validation errors.

11. From the **Options** menu in the Fiscal Documents window, select **Approve**. RTV NF will be changed to status NFe Pending until NFe integration is processed. Once that happens, NF will be changed to status Approved. The schedule will be changed to status Approved as well. Once NF is approved, inventory is updated in RMS.
ORFM supports the following inventory functionalities:

- Transfers
- Inventory Adjustment
- Customer Delivery NF

## Transfers

Transfer is the movement of merchandise from one location to another, either a warehouse or a store. When a transfer is initiated, ORFM creates and issues the related NF (based on the transfer information) for the merchandise to be transferred out. After the merchandise is shipped, the NF that was created, is matched with the related transfers in order to receive the merchandise in the receiving location.

Transfers can be of two types:

- Transfers (Regular, Intra-company and Inter-company, single-legged transfers)
- Two-legged Transfers (for finishing and repairing)

## Business Flow

The NF processing flow of intra-company transfers is identical to intercompany transfers. The process flow for Transfers can be divided into the following subprocesses:

- Transfers Creation in RMS
- Transfer Shipment at Warehouse
- Transfer Receiving at Store

### Transfer Creation in RMS

1. Create the transfer in RMS either manually or automatically through APIs or allocation or replenishment.

   **Note:** For information on creating transfers in RMS, see the *Oracle Retail Merchandising User Guide*.

2. For the manually-created transfers, enter a valid utilization code.

3. The transfer is interfaced with warehouse management system. If the transfer is initiated in warehouse management system as a stock order, it flows to RMS. If the
RMS initiated transfer is modified in warehouse management system, the modifications flows back to RMS.

Transfer Shipment at Warehouse
1. Create an outbound NF in ORFM after the merchandise are shipped in warehouse management system.

   The NF is based on the information provided by warehouse management system, which includes the transfer cost, and other master data.

   **Note:** For seamless NF processing, transfer information has to be available in the Oracle Retail Merchandising System (RMS) before the transfer is shipped from the shipping location.

2. The cost on the outbound NF generated is configurable based on the system option TSE_PURCHASE_PRICE. If this is set as Y, the last purchase price is the cost on the NF, else WAC if set as N.

   **Note:** The above configuration is valid for intra company transfers only.

3. Validate this NF. This NF is sent to Tax Engine to retrieve the CFOP, and for each line item and tax breakup details.

4. After the CFOP and tax breakup details are retrieved, approve the NF.

5. If the Auto-Approve indicator is enabled for the Utilization Code, the NF validation and approval is automatic.

6. As the outbound NF is approved, an inbound NF is created in the background in Validated status.

7. Print the NF and send it along with the shipment. The inventory in RMS has to be updated after the outbound NF is generated and approved.

Transfer Receiving at Store
1. After the shipment reaches the destination, retrieve the inbound NF that is available in ORFM.

   **Note:** Because the inbound NF is created using the outbound NF, validation exclusively for data integrity is not required. The tax breakup and CFOP information for the inbound NF is available as it is generated. The NF is created in Validated status.

2. Since the NF is in Validated status, submit the NF for receiving.

3. The NF receiving process is similar to the NF Processing for receiving except that there is no discrepancy and resolution process for transfers.
NF Processing for Transfers

Create the transfer, and set the utilization code for transfers in RMS. After the merchandise is shipped in warehouse management system, create the NF in Exit mode for the warehouse.

For Store to Store Transfers/Store to Warehouse Transfers/Warehouse to Store Transfers/Warehouse to Warehouse Transfers, the outbound NF is automatically generated on shipment. Here the NF status would be worksheet or approved depending on Auto Approve Indicator value set at utilization level. After NF approval, ORFM sends shipment details along with calculated cost to RMS. RMS updates inventory and post transaction data for stock ledger updates and financial postings. The Inbound NF is auto created in Validated status. To process shipment receipt, you need to manually trigger publishing of NF Schedule/ASN to receiving location through Submit NF for Receiving option on NF screen.

---

Note: For information about adding utilization codes for transfers, see the Oracle RMS/ReSA Brazil Localization User Guide.

---

To create the NF in the warehouse, do the following:

**Navigate**: From the RMS Start Menu, select Fiscal Management, then Login of Location. The Location Login window appears.

1. In the Location Login window, select the store/warehouse that is transferring the merchandise from the location list. Click OK. You are returned to the main menu.

2. From the RMS Start Menu, select Fiscal Management, then Receiving/Issue. In Contents Of Receiving/Issue window, click Edit. The Receiving/Issue Schedule window appears.

3. Select the schedule that is created in worksheet status. The Mode is Exit.

   ORFM creates an outbound NF based on the information that flows from warehouse management system.


5. In the Fiscal Docs Find window, click Add. The Fiscal Document window appears.

   In the Fiscal Document window, the differences in values of the fields are as follows:

<table>
<thead>
<tr>
<th>Fields</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requisition Type</td>
<td>Transfers. This field is disabled.</td>
</tr>
<tr>
<td>Mode</td>
<td>Exit</td>
</tr>
</tbody>
</table>

6. In the Fiscal Documents window, from the Options menu, select Validate. The CFOP and tax breakup is retrieved from Tax Engine.

   The Header Taxes details are as shown below:
The Details tab of the Fiscal Documents window displays the line item detail taxes.

7. If the Auto-Approve indicator is enabled for the Utilization Code, the validation process needs no manual intervention.

8. Print the approved outbound NF, and send it along with the shipment. The on-hand inventory is reduced at the source warehouse.

9. As the outbound NF is approved, an inbound NF is created in the background in Validated status with a new NF number.

Transfers at the Receiving
1. At the receiving store, select the location from the location list in the Location Login window.

2. Validated inbound NF is generated based on the approved outbound NF for the transfer.

3. In the Receiving/Issue Schedule window, select the schedule with the inbound NF. The schedule is in Pending for Receiving status.
4. In the Receiving/Issue Schedule window, click **Submit**. The receiving process is similar to that of PO Receiving, except that there is no discrepancy identification and resolution process available for transfers.

5. As the merchandise is received, the status of NF changes to **Approved**.

**Business Flow for Two-Legged Transfer**

The business flow for two-legged transfer can be divided into three sub-processes as follows:

- **Transfer Creation**
- **Two-Legged Transfer Shipment**
- **Two-Legged Transfer Receiving**

**Transfer Creation**

- For two-legged transfers, create the transfer in RMS. If the transfer type is repair, the context type is Repairing. After the transfer is approved, RMS creates the second leg of the transfer as a separate transfer.
- RMS publishes the first transfer to warehouse management system or store inventory management system.
- If the context type is Repair, warehouse management system takes in the message and creates a stock order, where type = Repair.

---

**Note:** Stock orders where type = Repair are not selected in Wave. Repair stock orders are handled separately.
In order to repair the merchandise, initiate a transfer in either WMS or RMS. If the transfer is used for stocking or finishing the merchandise, you must initiate the transfer in RMS only.

Two-Legged Transfer Shipment
- After the merchandise is sent from either the warehouse management system or the store inventory management system, the shipment information is published. ORFM uses this shipment information. A NF is generated in Exit mode.
- The transfer cost on the exit NF is equal to the weighted average cost (WAC). The taxes and CFOP are retrieved from Tax Engine.
- After the approved NF is printed, the shipment is ready to move out of the location. The inventory in RMS is updated as the outbound NF is approved.
- If the auto-receiver indicator is enabled at the finisher location, the in-transit quantities at the finisher location are automatically cleared. If the indicator is not enabled, RMS receives the receipt details.

It is assumed that the shipment quantity has been received at the finisher.

Two-Legged Transfer Receiving
- When the finished/repaired merchandise is to be returned to the supplier, a valid NF has to be generated.
- Enter the NF in the system that is generated by the repairer/finisher. This is inbound flow.
- Validate the NF for data integrity, and send it to Tax Engine for inbound CFOP determination. Tax Engine does not return the taxes, as there is no discrepancy identification done for this transaction.
- Submit the schedule containing this NF to store inventory management system or warehouse management system.
- After physical receipt, ORFM uses the receipt message to process the NF. The application processes the NF as any other entry NF.

NF Processing for Two-Legged Transfers
For processing of two-legged transfers in ORFM, you have to create the transfer in RMS with the context type as Repairing. The warehouse management system has to publish the shipment information before the NF processing for two-legged transfer is initiated in ORFM. ORFM generates a outbound NF in Approved status, based on the shipment information provided by warehouse management system.

For Two legged transfers with finisher, Outbound NF is automatically generated on shipment. Inbound NF needs to be manually generated. While capturing Inbound NF details in ORFM, you need to identify 'from' location as finisher.

NF Processing for Two-Legged Transfer Shipment
To process NF for the two-legged transfer shipment, do the following:

Navigate: From the RMS Start Menu, select Fiscal Management, then Login of Location. The Location Login window appears.

1. In the Location Login window, select the store or warehouse that has to receive the shipment for repairing/finishing. Click the Location LOV to obtain the list of stores or warehouses. Select the location, and click OK.
2. In Contents of Fiscal Management, click **Receiving/Issue**. In Contents of Receiving/Issue, click **Edit**. The Receiving/Issue Schedule window appears. On the Receiving/Issue Schedule window, click the outbound NF generated by ORFM.

3. Click **Fiscal**. The Fiscal Docs Find window appears.

4. Click **OK**. The Fiscal Documents window appears.

   In the Fiscal Document section, the Requisition Type is displayed as Repairing, and the Utilization field displays the values set in the RMS Transfer Maintenance screen.

   If the Auto Approve parameter is set to ‘Y’, the NF is automatically approved. Otherwise, the NF has to be manually approved.

5. The inventory in RMS is updated, after the NF is approved.

**NF Processing for Two-Legged Transfer Receiving**

1. In the Location Login window, select the location that receives the merchandise after the repairing/finishing work is done.

2. To receive the repaired/finished merchandise, create the schedule in worksheet status. Click **Add** in the Receiving/Issue Schedule window. The NF is created in Entry mode.

3. Select the schedule and click **Fiscal** in the Receiving/Issue Schedule window. The Fiscal Docs Find window appears.

4. Click **Add**. The Fiscal Documents window appears. Select **Repairing** from the Requisition Type LOV for this NF. Select the Utilization from the list. Set the Sub Type to **External Finisher**.

5. From the **Options** menu, select **Validate**. If there are no errors, the NF status changes to **Validated**.

6. Click **OK**. You are returned to the Receiving/Issue Schedule window. In the Receiving/Issue Schedule window, from the **Options** menu, select **Sub. for Recv**. The NF is submitted for receiving.

7. If there are no errors, from the **Options** menu, select **Approve**. The NF is approved, and the merchandise that has been repaired/finished can be received.

**Note:** Based on the NF-e line limit set and the item having the grouping attribute flagged or not (ST break out), the shipment is broken into multiple NFs in ORFM.

**Entry Complementary NF Receiving for Transfers and Intercompany Transfers**

The Fiscal Documents window has been adjusted for the receiving of Complementary NF for the Requisition Types TSF (Transfer) and IC (Intercompany Transfers).

Therefore you can select entry utilizations for the Transition Types TSF (Transfer) and IC (Intercompany Transfers) while entering a CNF.

The **Complement** button in opens the Complement Fiscal Doc window to associate the Complementary NF with the Main NF.
Transfer Return

The following fiscal utilization setups have been created to distinguish Transfer Returns from conventional Transfers:

- **Transfer Return Outbound**
  Setup:
  - Requisition Type is Transfer.
  - Issue type is Issue.
  - Mode type is Exit, since it is an exit transaction.
  - The Nature of Operations is associated with the NOP used to identify the transaction as Transfer Return.

- **Transfer Return Inbound**
  Setup:
  - Requisition Type is Transfer.
  - Issue type is Include.
  - Mode type is Entry, since it is an entry transaction.
  - The Nature of Operations is associated with the NOP used to identify the transaction as Transfer Return.

- **TSF (Transfer) Return Inter Outbound, for Exit Return Transfer Inter-company**
  Setup:
  - Requisition Type is Inter Company (IC).
  - Issue type is Issue.
  - Mode type is Exit, since it is an exit transaction.
  - The Nature of Operations is associated with the NOP used to identify the transaction as Transfer Return Inter-company.

- **TSF (Transfer) Return Inter Inbound, for Entry Return Transfer Inter-company**
  Setup:
  - Requisition Type is Inter Company (IC).
  - Issue type is Include.
  - Mode type is Entry, since it is an entry transaction.
  - The Nature of Operations is associated with the NOP used to identify the transaction as Transfer Return Inter-company.

Inventory Adjustment

Inventory adjustments allows total stock-on-hand (SOH) adjustments or unavailable (un-sellable) inventory for one or more item/locations.
In Brazil:

- Stock outs may have taxes associated and requires the generation of a NF to properly account for them.

- NFs can be generated based on inventory adjustments with proper setup through the link of a reason code in the Utilization configuration screen. The reason code must be the same code used in the inventory adjustment coming from inventory management system.

- NFs generated based on a negative inventory adjustment are restricted to stock out transactions. For this type of transaction, the NF is issued in ‘Exit’ mode with source and destination being the same location that created the inventory adjustment.

- Retailers can use inventory adjustment functionality associated to NF generation in order to support different fiscal processes such as 'donation' where the NF must be generated similarly to a stock out, but the destination is a third party entity, not the same as the source location. In this scenario the setup of the Utilization and Reason code is different and the NF is generated using the Standalone NF mode. This type of transaction supports negative and positive inventory adjustments.

**Business Flow**

**Negative Stock Out Inventory Adjustments**

*Figure 5–4 Utilization Setup Form*

1. The Utilization options are as follows:
   - Requisition type "Stock Out"
   - Issue "Issue"
   - Nature of Operation (must be configured accordingly to Tax Engine)
   - Mode "Exit"

2. Select **Reason Code** under **Options** menu.
3. The Reason code to be used must have same value of the inventory adjustment reason code set in WMS or SIM.

**Note:** The other options in Options menu (Parameters and Doc Type) must be configured accordingly. For more information, see the Utilization setup section.

**Processing Flow**

1. The store inventory management system, or the warehouse management system publishes the details of the negative inventory adjustment with the reason code previously configured in ORFM.

2. ORFM consumes the inventory adjustment and based on the utilization setup, creates an Exit NF.

3. If the auto-approve parameter of the utilization code is set to 'Yes', validation, and approval of the NF happens automatically. If the auto-approve parameter of the utilization code is set to 'No', validate and approve the NF manually.

4. After the NF has been approved, the inventory is updated in RMS.

**Note:** Based on the stock out Utilization setup, only negative inventory adjustments will generate a NF. Positive inventory adjustments are not supported in this type of setup.

**Inventory Adjustments with NFs generated to third parties**

The configuration necessary in order to generate a standalone NF based on an inventory adjustment are as follows:
1. The Utilization options are as follows:
   - Requisition type "Direct NF"
   - Issue "Issue"
   - Nature of Operation (must be configured accordingly to Tax Engine)
   - Mode "Exit"

2. Select **Reason Code** under **Options** menu.

3. The Parameters option in **Options** menu must only have the following options enabled for this type of setup:
   - ICMS-ST Recovery
   - Item Utilization

4. All other options must be disabled.

**Note:** If an ORFM user selects the option “ICMS-ST Recovery”, the system cannot allow the deletion of the reason code associated.
Processing Flow

1. The store inventory management system, or the warehouse management system publishes the details of the negative or positive inventory adjustment with the reason code previously configured in ORFM.

2. ORFM consumes the inventory adjustment and based on the utilization setup, creates a Standalone NF.

3. You need to access the NF form and complete the source or destination entity data in order to validate and approve the NF. In this scenario there is no auto-approve option.

4. After the NF has been approved, the inventory is updated in RMS.

In case of a negative inventory adjustment configured to generate standalone NF:

1. ORFM will automatically create an exit Standalone NF considering the utilization associated to the inventory adjustment reason code.

Figure 5–8 NF Header Form

2. ORFM user will be able to choose whatever third party as the 'addressee' of this Standalone NF.

Figure 5–9 NF Header Form
In case of a positive inventory adjustment configured to generate standalone NF:

1. The fields in the tab Destination Details are automatically filled with the location data that is creating the Entry NF and to which the goods will be received.

   **Figure 5–10   NF Header Form**

   ![NF Header Form Image]

2. The tab Source Detail will be left for user to complete and will represent the origin of the transaction.

   **Figure 5–11   NF Header Form**

   ![NF Header Form Image]

**Customer Delivery NF**

Brazilian retailers dealing in hard lines (electronics and furniture) or selling through e-commerce channel often take customer orders and ship merchandise directly to customers. For every customer order delivery of merchandise, they issue a Customer Nota Fiscal document to accompany the delivery.

Customer Orders are generated in external Customer Order Management (COM) system. Customer Orders are based on special orders created at a physical (brick and mortar channel) store or a virtual (e-commerce channel) store. Virtual e-commerce channel stores may be defined by client as per their business requirements. For example, they may be defined based on FedEx, United Parcel Service (UPS) delivery methods.
External COM system custom interfaces customer order details to RMS for further processing. In response to this request, RMS generates a Customer Order Transfer between warehouse and virtual store. RMS publishes this customer order transfer to the warehouse management system for picking and shipping of inventory for customer delivery. The warehouse management system communicates shipment details by publishing an ASN Out to ORFM/RMS. ORFM consumes this ASN Out and auto-generates a Customer Delivery NF of sales requisition type to accompany the shipment. This NF may be printed and included in the delivery. Processing of Customer Order shipment is similar to transfer shipment. Primary difference is that only exit NF is generated in case of Customer NF, whereas both exit and entry NFs are generated for transfer shipments.

ASN Out is custom interfaced to External COM system and the External COM further interfaces customer order fulfillment sale transaction details to Oracle Retail Sales Audit (ReSA) for special order fulfillment sale posting.

**Figure 5–12  Fiscal Documents (fiscal_header) window with Sales Requisition Type**

---

**Note:** Customer Delivery NF is generated in Validated status and requires manual intervention for approval, if Auto Approve Indicator for its utilization is N (No). Customer Delivery NF is validated and generated in Approved status, if Auto Approve indicator is Y (Yes).

---

**Customer Delivery NF - Future Delivery Flow**

A Future Delivery is the requirement where a customer places an order and receives the NF (Sale/Invoice), but the product is delivered on a future date. Therefore it is necessary to issue a second NF (Shipment). One or multiple shipments can be related to same Sale/Invoice NF. The Delivery covers the total of goods, just one NF for the Shipment will be issued.

The Future Delivery transaction can be a choice by the customer (end consumer) for convenience, or by the retailer mainly when there is not enough stock on hand but is expected to be on hand sometime in the future.

The following enhancements have been made in ORFM to handle Customer Order - Future Deliveries:

The Customer Order is captured by the OOC and then sent to OMS. OMS requests the Sale/Invoice NF from RFM, indicating that it is a Future Delivery CO, which is created with no association to a shipment. Only one NF can be issued for each Customer Order Future Delivery Sale.

Specific utilizations for each NF (Invoice and Shipment) are created to identify this transaction for tax calls purposes.

Later on, OMS submits a Customer Order fulfillment to a physical location (SIM or WMS), that results in a delivery NF requested to RFM. This request states that it is only a regular Sale.
Return Merchandise Authorization

The Return Merchandise Authorization (RMA) process occurs when the customer wants to return the merchandise without visiting the store.

In order to implement the RMA process, the merchandise management system (RMS) and warehouse management system (WMS) applications have to be integrated with a third-party Customer Order Management (OMS) system. OMS is the application that is responsible for managing customer orders throughout their lifecycle and communicates with WMS and RMS and other applications the details of customer orders for fulfillment, sales and return processing. Once the return authorization is sent to WMS, it is expected that the information related to the physical receiving of the goods is sent from WMS to RMS and OMS. Based on the physical receiving, OMS will provide information to ORFM for the generation of the inbound Nota Fiscal for RMA.

This chapter covers the following section:

- Business Flow

## Business Flow

1. In case the integration with OMS happens through web service, the RMA NF will be created in worksheet or approved status, depending on the configuration for auto-approve in RMA utilization.

   **Note:** The validation depends on the auto-approve parameter for the utilization for that NF. If the Auto-approve parameter for the utilization is set to ‘y’, then the NF is validated automatically. Otherwise, the validation has to be done manually.

2. Validate the NF either manually or automatically.

3. Approve the NF if applicable. The NF changes to **NFe Pending**. Once the NFe integration returns the NFe approval, the NF will be in Approved Status.

## NF Processing for RMA

To process NF for RMA, do the following:

**Navigate:** From the RMS Start Menu, select Fiscal Management, then Login of Location. The Location Login window appears.

1. In the Location Login window, select the store or warehouse for issuing the fiscal document. Click the LOV in the Location field to obtain the list of stores or warehouses. Select the location, and click OK.

*Figure 6–1  Fiscal Find Window*

3. Click Action. From the LOV, select Edit.

4. Use the filters to search for RMA NFs to work.

*Figure 6–2  Fiscal Find Search Results Window*

5. Click Detail in the selected RMA NF. The selected document is displayed in the Fiscal Docs Header window.

*Figure 6–3  Fiscal Documents Window*
6. Depending on the status of the RMA NF, you can either validate or approve it and follow the next status flow.

---

**Note:**

- The RMA NF steps of the above flow does not depend on the integrations between OMS and RMS/WMS that are part of the base RMA process, however it is expected that the steps required in base process happen even in a localization scenario.

- The inventory updates in WMS and RMS that are the result of these base integrations are expected to happen irrespectively of the RMA NF flow. The RMA NF will not update inventory, nor will have any impact on the RMS inventory postings (trandata).

- Approved NFs can be taken by FM TRANDATA and financial posting batches. Once RMA NF is in FP status, it will be enabled for fiscal reporting.

---
Fiscal Documents for all the requisition types discussed in the previous chapters can be accessed using the Fiscal Docs Find window.

This chapter covers the following section:

- Accessing Fiscal Documents

**Accessing Fiscal Documents**

You can access the individual NFs from the schedule screen or directly from the main menu.

To access the NF from the main menu, do the following:

**Navigate:** From the RMS Start Menu, select Fiscal Management, then Fiscal Documents. The Fiscal Docs Find window opens.

---

In the Fiscal Docs Find window, the Action field has a list, which contains the following:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>To create a new NF, select this Action.</td>
</tr>
<tr>
<td>View</td>
<td>Only to view the NF. The NF cannot be edited when the Action is View.</td>
</tr>
</tbody>
</table>
Creating a New NF

To create a new NF, do the following:

1. In the Fiscal Docs Find window, select New from the Action field, and click **OK**.
2. In the Fiscal Documents window, enter the details given in **Fields in the Fiscal Document Header Section**.
3. From the Options menu, select Validate. This will validate the details entered in the Fiscal Documents Details section.
4. Click **OK**. The Fiscal Docs Find window appears.
5. Click **Close** to exit the window. You are returned to the Fiscal Docs Find window.

### Table 7–1 (Cont.) Fields in the Fiscal Docs Find window

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit</td>
<td>To edit the NF, select this Action.</td>
</tr>
<tr>
<td>Fiscal Document Section</td>
<td></td>
</tr>
<tr>
<td>Fiscal No</td>
<td>Enter the fiscal number here.</td>
</tr>
<tr>
<td>Schedule No</td>
<td>Enter the schedule number in this field.</td>
</tr>
<tr>
<td>Mode Type</td>
<td>The mode type can be either Entry or Exit. Select from the list.</td>
</tr>
<tr>
<td>Document Type</td>
<td>Select the document type from the list.</td>
</tr>
<tr>
<td>Status</td>
<td>Select the status of the NF from the list.  The link includes: Worksheet, Validated, Error, Subm. for Recv., In Discrepancy, Approved, Pending for Receiving, Inactive, Received, NFe Pending, Receipt Verified, Cancelled, Nullified by SEFAZ, Completed, Post Sefaz Approve Error, Financials Posted.</td>
</tr>
<tr>
<td>Utilization</td>
<td>Select the Utilization from the list.</td>
</tr>
<tr>
<td>CFOP</td>
<td>Enter the CFOP number here.</td>
</tr>
<tr>
<td>NFe Access Key</td>
<td>Applicable only for NFe.</td>
</tr>
<tr>
<td>Sender/Receiver Section</td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td>This is external entity type from which the NF is received.  The list includes Supplier, Partner, Location, Outside Location, Company, and Customer.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter the name of the sender/receiver</td>
</tr>
<tr>
<td>Sub Type</td>
<td>Select the value from the list.</td>
</tr>
<tr>
<td>CNPJ/CPF</td>
<td>Select the CNPJ/CPF from the list.</td>
</tr>
<tr>
<td>Dates Section</td>
<td></td>
</tr>
<tr>
<td>Issue</td>
<td>Date of issue or stock receipt. Select from the date editor.</td>
</tr>
<tr>
<td>Entry/Exit</td>
<td>The date the NF was entered.</td>
</tr>
<tr>
<td>Exit Hour</td>
<td>The exit time of the NF.</td>
</tr>
<tr>
<td>Doc Detail Section</td>
<td></td>
</tr>
<tr>
<td>Requisition Type</td>
<td>Select the Requisition Type from the list.  The list includes Purchase Order, Transfer, Return to Vendor, etc.</td>
</tr>
<tr>
<td>Doc</td>
<td>If the requisition type is PO, the Doc list includes the list of POs.</td>
</tr>
<tr>
<td>Item</td>
<td>Select the items on the PO.</td>
</tr>
</tbody>
</table>
Searching Fiscal Documents

To search the Fiscal Documents, do the following:

1. In the Fiscal Docs Find window, select Edit from the Action field.

2. After entering the search criteria, click **Search**. The Fiscal Docs Find window appears. All the NFs that meet search criteria are displayed.

```plaintext
Figure 7–2  Fiscal Docs Find Window
```

3. Select the NF and click **OK**. The Fiscal Documents window appears. Here you can view and edit the NF details.

4. The following buttons are enabled only when the Fiscal Docs Find window is accessed through Schedule window:
   - **Add** – Click **Add** to add NF details in the Fiscal Document window.
   - **Link** – Click **Link** to link an NF to a schedule.
   - **Delink** – Click **Delink** to remove an NF from a schedule.

5. Click **Refresh** to return to the previous window and enter the criteria again.

6. Click **Close** to exit the window. You are returned to the Fiscal Docs Find window.

Searching using Vendor Product Number in the Fiscal Docs Find window

To search using the Vendor Product Number (VPN) in the system, do the following:

1. In the Fiscal Docs Find window, select Edit from the Action field.

2. Click in the **Item** field, in the **Doc Details** section.

3. From the **Options** menu, select **Item Number Type**. The Item Number Find window appears. The fields and descriptions are given below:

```
Table 7–2  Item Number Find Fields and Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference Item</td>
<td>The reference item ID and description.</td>
</tr>
<tr>
<td>VPN</td>
<td>The Vendor Product Number and description.</td>
</tr>
<tr>
<td>Line</td>
<td>The Line ID and description.</td>
</tr>
<tr>
<td>Item</td>
<td>The Item ID and description.</td>
</tr>
</tbody>
</table>
```
4. Enter the VPN number. The VPN description, Line ID, and Line description fields are pre-populated.

5. Click OK. The Fiscal Docs Find window appears with the item number and description fields pre-populated.

Searching using Vendor Product Number in the Fiscal Documents window

To search using the Vendor Product Number (VPN) in the system, do the following:

1. In the Fiscal Docs Find window, click Add.

2. In the Fiscal Documents Window, enter the details in the Fiscal Documents Details section, and Header section.

3. Select Item in the Line Item Details section. From the Options menu, select Item Number Type. The Item Number Find window appears. The fields and descriptions are given below:

4. Enter or select the VPN number. The VPN description, Line ID, and Line description fields are pre-populated.

5. Click OK. The Fiscal Documents window appears.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference Item</td>
<td>The reference item ID and description.</td>
</tr>
<tr>
<td>VPN</td>
<td>The Vendor Product Number and description.</td>
</tr>
<tr>
<td>Line</td>
<td>The Line ID and description.</td>
</tr>
<tr>
<td>Item</td>
<td>The Item ID and description.</td>
</tr>
</tbody>
</table>

**Note:** The item number and description fields are pre-populated.

Exit Complementary NF

Exit Complementary NF is generated when taxes or any additional cost is required to augment the value of a previously generated NF that by any reason had incorrect values. The Exit complementary NF can be generated in ORFM and linked to any previously generated NF. Free Form Standalone NF is leveraged to generate exit complementary NF and proper setup in utilization is required to enable this functionality.
New Behavior for Exit Complementary NF

To facilitate the NF creation process and avoid errors when entering required data for the generation of NF, the system leads you through the form.

The Detail Info tab only displays the required fields for generating the Exit CNF:
- NF CFOP
- Quantity
- UnitCost
- PIS
- COFINS
- Classification CST
- Fiscal Doc Ref
- Totalcost

New Behavior for Associating Exit Complementary NF with Main NF

The Exit Complementary NF is a FFNF but you can associate the NF with a Main NF. To associate the Exit Complementary NF with the Main NF, follow the steps below.

1. In the Header Info tab, enter the Main NF number directly in the Comp No field, or use the Complement button to open the Complement Fiscal Doc window.

   Figure 7–4 Complement Fiscal Doc

2. Use the Utilization filter to search for the Main NF by operation or transaction to associate with the Exit Complementary NF.
3. Select the appropriate utilization and press OK.

4. You are prompted if you want to copy the data from the Main NF, or if you want to manually enter the Exit CNF data.

    Figure 7–5 New Prompt for Exit CNF

![New Prompt for Exit CNF](image)

**Note:** The system also displays this prompt when you enter the Main NF number directly in the **Comp No** field.

    a. If you select Yes, the system automatically loads all data from the Main NF.
    b. If you select No, you have to enter the following information manually in the Fiscal Document window.
       - In the Fiscal Document section, enter the NF CFOP.
       - In the Destination Details tab, enter all information associated with the destination.
       - In the Detail Info tab, enter all information associated with the items.
       - In the Header Taxes tab, enter all information associated with header taxes.
       - In the Detail Taxes tab, enter all information associated with item taxes.

5. Click OK to save your entries.

**New Validation Rules for Exit Complementary NF**

The following validation rules for Exit Complementary NF have been implemented.

**Complement Number Required**

If you do not enter the Main NF in the Comp No field, the system displays the following error message when you are trying to navigate to other windows.

    Figure 7–6 Comp No Required for Exit CNF

![Comp No Required for Exit CNF](image)

**Fiscal Doc Ref Automatically Entered**

In the Detail Info tab, the **Fiscal Doc Ref** field displays the Complement Number automatically. You cannot enter any value.
No Values Permitted
In the Detail Info tab, you are not permitted to enter any values in the Quantity and Unit Cost field.

Only One Exit CNF associated with One Main NF
You can only associate one Exit CNF with one Main NF. Therefore, the Main NF is displayed in the Comp No field of the Header Info tab and not in the Fiscal Doc Ref field in the Detail Info tab.
The NF-e issuer generates an electronic file with all NF information in a more detailed level than the regular NF. This file must be digitally signed to guarantee the integrity of the data and the authorship of the issuer. This electronic file is transmitted by the internet to the Secretaria da Fazenda - Brazilian Tax Authority (SEFAZ) in the origin state of the issuer. The SEFAZ provides a pre-validation of the file and returns a receiving protocol (Authorization for Use), necessary for the movement of merchandise.

The ORFM application allows the generation of NF-e by location and utilization code. A new system option is used to identify the location that issues the NF-e. NF-e is applicable only for transactions such as transfers, intercompany transfers, and RTVs.

This chapter covers the following sections:

- NF-e Processing
- Cancelling NF Invoice

**NF-e Processing**

To enable NF-e processing, the utilization and document type setup must be done with the proper NF Model Type. If a configured utilization is used in the creation of a NF, it will trigger NF-e integration.

NF-e is applicable for all transactions where the NF is issued from ORFM. This includes Direct Import NF, Return NF, RTV, Transfers, Stock, Customer NF, Direct NF, and Free Form NF where ORFM generates the NF.

The flow is the same as the one defined for the transfers, intercompany transfers, and RTVs.

The change in process is as follows:

- Create an outbound NF.

- The document type will be filled with the type associated to the utilization ID for the transaction. If the doc type has a model type set as NF-e (55 or 65) NF-e integration will be called for this transaction.

- Once the NF-e is validated, the status of the NF-e changes to **NF-e Pending**. With the fiscal document in that status, the related information is sent to the fiscal partner solution. The fiscal partner solution captures the data, generates the NF-e file, and submits it for approval in the Government systems.
Cancelling NF Invoice

An internal sequence is used during NF creation in the ORFM database. The internal sequence associated with the NF is stored in the database even when you submit the NF. NFs not associated to the official sequence is called pre-NF.

You will be able to see the pre-NF number in the Fiscal Documents form in the same field of the NF Fiscal Number. The label of this field will be dynamically updated while the Pre-NF Number is displayed. Once the NF is sent for approval, this field will be renamed to Fiscal Number and will hold the official NF-e number consumed from the sequence. Serial and sub-serial fields will also be updated only when the official sequence is consumed.

You can cancel the NF invoice during the process of NF creation, approval, and after the NF is approved from the Fiscal Docs Find form.

Following are the scenarios to cancel the NF:

- Scenario 1: When the NF is in progress and it was not submitted for approval at SEFAZ
- Scenario 2: When the NF is submitted for approval at SEFAZ but it gets rejected or denied
- Scenario 3: When the NF is approved at SEFAZ and a cancelation is required post-approval

Note: Only NFs issued by ORFM can be canceled through the NF Cancelation form.

To cancel the NF, do the following:

From the RMS Start Menu, select Fiscal Management, then Fiscal Documents.

1. In Contents Of Fiscal Documents, select Fiscal Documents. The Fiscal Docs Find window appears.
2. Select either View or Edit from the Action list.
3. From the Options menu, select NF Cancelation as shown in Figure 8–1.
The NF Cancelation window appears.

Figure 8–2 NF Cancelation Window

Table 8–1 NF Cancelation Fields and Description

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schedule</td>
<td>This field displays the schedule number if available.</td>
</tr>
<tr>
<td>Location ID</td>
<td>This field displays the location ID.</td>
</tr>
<tr>
<td>Location</td>
<td>This field displays the description of the location that issued the NF-e or created the schedule.</td>
</tr>
<tr>
<td>User:</td>
<td>This field displays the User ID logged in the form.</td>
</tr>
<tr>
<td>Pre NF No</td>
<td>This field displays the pre-NF sequence number.</td>
</tr>
<tr>
<td>Fiscal No</td>
<td>This field displays the fiscal document number.</td>
</tr>
<tr>
<td>Status</td>
<td>This field displays the fiscal document status.</td>
</tr>
<tr>
<td>Requisition Type</td>
<td>This field displays the requisition type.</td>
</tr>
<tr>
<td>Issue Date</td>
<td>This field displays the fiscal document issue date.</td>
</tr>
<tr>
<td>Canc.Status</td>
<td>This field displays the status of the cancelation action.</td>
</tr>
</tbody>
</table>
4. Click **NF Cancelation**. The list displays the NFs that are scheduled to be cancelled.

5. Click **OK**. The NFs and schedule displays the Cancelation in Progress status and the form will be closed.

6. Click **Cancel** to cancel the transaction.

---

### Table 8–1 (Cont.) NF Cancelation Fields and Description

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Canc. Protocol</td>
<td>This field displays the cancelation protocol number returned by the NFe integration.</td>
</tr>
<tr>
<td>Canc. Req. Date</td>
<td>This field displays the date for when the NF-e cancelation request was submitted to NF-e solution.</td>
</tr>
<tr>
<td>Logs</td>
<td>This field displays the error log message returned by NFe integration.</td>
</tr>
<tr>
<td>Inventory Reversal Steps</td>
<td>This field will be dynamically populated with the pre-defined inventory reversal step for each type of transaction.</td>
</tr>
<tr>
<td>Result</td>
<td>This field will be updated with the status of the step execution (success or failed).</td>
</tr>
<tr>
<td>Logs</td>
<td>This field displays the error log for each step.</td>
</tr>
</tbody>
</table>
The Oracle Retail Merchandising System records each transaction (such as PO, Transfers, and RTV) in a transaction table. Each transaction may post one or more transaction codes into the transaction table. ORFM offers option to map these transaction codes with the accounts payable or the general ledger accounts.

The Account Payables (AP) interface has been designed to accept data that will be used to create Payment Vouchers and initiate a payment to a vendor. NFs for Purchase Orders, RTVs, and complementary NFs related to purchases as well as any for non-merchandise costs must be posted to the AP Interface. However, any NFs that are not intended to pay an outside party must be posted to General Ledger (GL) interface. For example, these would include NFs for Transfers and Inventory Adjustments.

In ORFM, the postings to AP and GL modules of Enterprise Business Suite (EBS) could depend on attributes like utilization code, Tax Code, Cost Component, and Reason Code on the NF based on the transaction. For example, for purchases, different AP accounts may be impacted based on the utilization code on the NF. Also, the recoverable and non-recoverable taxes could be maintained in separate accounts depending on the Tax Code.

In addition, new documents like Return NF and the Correction Letter that are generated during the discrepancy resolution process, will also have to be interfaced with AP.

The ORFM application uses predefined parameters to pass the relevant values to the accounts of AP.

To enable financial integration, store the data in a specified format in ORFM.

This chapter covers the following section:
- Business Flow

### Business Flow

The business flow for how ORFM does the transaction data posting is given below:
The overall process is divided into the following two sub-processes:

1. **Define Transaction Codes**—The ORFM application provides a table with the list of predefined transaction codes used for transaction data posting. For each transaction, the transaction code, and the information that is posted vary. For different transaction type, the postings are as given below:
   - For PO Receiving the merchandise cost exclusive of taxes, recoverable taxes, non-recoverable taxes, and the non-merchandise cost exclusive of taxes are posted as a part of transaction data.
   - For Transfers, only the recoverable, and non-recoverable taxes are posted.
   - For rural producers, only the corrected NF is posted to the transaction table. The original NF is not posted.
   - For triangulation NF, the original NF along with the ICMS/ICMS-ST details based on the complementary NF are posted.

   **Note:** For the different transaction codes, refer to the RMS Implementation Guide.

2. **Transaction Data Posting**—The ORFM application provides a batch program to post all the approved NFs in the transaction table.

   The process is divided into the following two broad areas:
- Account Setup
- Financial Posting

Figure 9–2 displays the process flow for Account Setup.

**Figure 9–2  Process Flow for Account Setup**

- Start
- Chart of Account Setup
- Set of Books Setup
- GL account mapping
- End

This is a 3 step process:
1. Define COA
2. Define Accounts in the COA
3. Define Dynamic segments in the COA

Figure 9–3 displays the process flow for Financial Posting.
Dynamic Segment Setup
The Dynamic Segment Setup form is used to dynamically determine the account code by using data from the transaction level and using the same to derive the segment values for individual entity IDs.
Editing and Viewing the Dynamic Segment Configuration
To edit or view the Dynamic Segment Configuration, do the following:

1. Choose the RMS Start Menu.
2. Select Fiscal Management > Finance.
3. In the Contents of Finance, select Dynamic Segment Setup.
4. In the Contents of Dynamic Segment Setup, click Edit/View.

The Dynamic Segment Configuration window appears.

Figure 9–4 Dynamic Segment Configuration Window

Table 9–1 Dynamic Segment Configuration Fields and Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart of Account</td>
<td>Enter the Chart of Account ID or select from the List of Chart Accounts.</td>
</tr>
<tr>
<td>Financial System</td>
<td>Select the <strong>Financial System</strong> list to setup the following dynamic mappings:</td>
</tr>
<tr>
<td></td>
<td>■ Accounts Payable</td>
</tr>
<tr>
<td></td>
<td>■ General Ledger</td>
</tr>
<tr>
<td>Search</td>
<td>ORFM will search for the existing dynamic mapping records for the specified Chart of Accounts ID.</td>
</tr>
<tr>
<td>Entity Type</td>
<td>You can select the Entity Type for which the dynamic segment values are required from the list of Entity Type.</td>
</tr>
<tr>
<td></td>
<td>Following are the values displayed in the list of Entity Type:</td>
</tr>
<tr>
<td></td>
<td>■ Department</td>
</tr>
<tr>
<td></td>
<td>■ Class</td>
</tr>
<tr>
<td></td>
<td>■ Subclass</td>
</tr>
<tr>
<td></td>
<td>■ Location</td>
</tr>
<tr>
<td></td>
<td>■ Transfer Entity</td>
</tr>
<tr>
<td>Entity ID</td>
<td>The Entity ID is populated based on the Entity Type selected. You can also select the Entity ID for which the segment value needs to be defined from the List of Values.</td>
</tr>
<tr>
<td>Segment No</td>
<td>The Segment No is populated based on the segment number in the COA that holds the dynamic values based on the entity types. You can also select the Segment Number from List of Segment Numbers.</td>
</tr>
<tr>
<td>Segment Value</td>
<td>The Segment Value is populated from the account setup based on the segment number selected.</td>
</tr>
</tbody>
</table>
5. Click **OK** to exit.

The Contents of Dynamic Segment Configuration Setup appears.

6. Click **Refresh** to add new COA setup.

7. Click **Add** to add an Entity Type from the Entity Type list.

8. To delete the record, select the record from the multi-record block, and click **Delete**.

   The following message appears.

   ![Message Window]

   9. Click **Yes** to delete the record or, click **NO** to retain the record.

10. Click **Cancel** to undo the changes you specified in the multi-record block.

General Ledger (GL) Cross Reference

ORFM maps transactions to appropriate accounts in GL and AP system.

Creating General Ledger Cross Reference

To create the General Ledger Cross Reference, do the following:

1. Choose the **RMS Start Menu**.

2. Select **Fiscal Management > Finance**.

3. In the **Contents of Finance**, select **GL Cross Reference**.

   The General Ledger Search window appears.

   ![General Ledger Search Window]

   4. In the **Action** field, select **New**.

   The Set Of Books (SOB) field is enabled.
5. Enter the Set Of Books ID, or select from the List of Set of Books.

6. Click OK.

The GL Cross Reference window appears.

Figure 9–6  GL Cross Reference Window

Note: The **Financial System** field is editable only to search an existing cross reference setup. The **Financial System** field is not applicable for **New** option.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sequence No.</td>
<td>It is an identifier for selecting a particular cross reference setup.</td>
</tr>
<tr>
<td>Financial System</td>
<td>It is used to select the Financial System for which cross reference is defined. Valid values for Financial System are Accounts Payable or General Ledger.</td>
</tr>
<tr>
<td>Set Of Books</td>
<td>Displays the SOB ID.</td>
</tr>
<tr>
<td>Transaction Code</td>
<td>It is an unique identifier for the TYPE of transaction. The Transaction Code description is displayed when you enter a Transaction Code. The LOV can also be used to select a Transaction Code.</td>
</tr>
<tr>
<td>Utilization</td>
<td>Utilization is displayed based on the Transaction Code selected. The description of Utilization is displayed by default. You can also select Utilization from the List of Utilizations.</td>
</tr>
<tr>
<td>Tax Code</td>
<td>The Tax Code is displayed based on the Transaction Code selected. The description of Tax Code is displayed by default. You can also select Tax Code from the List of Tax Codes.</td>
</tr>
<tr>
<td>Reason Code</td>
<td>The Reason Code is displayed based on the Transaction Code selected. The description of Reason Code is displayed by default. You can also select Reason Code from the List of Reason Codes.</td>
</tr>
</tbody>
</table>
7. Click **OK**.

The General Ledger Search window appears.

8. Click **Ok+Repeat**.

Clears all the fields to configure a new segment setup with the dynamic attributes for a new selected SOB.

9. To delete the record, select the record from the action block, and click **Delete**. The **Delete** field is available to the user in **Edit** mode.

The following message is displayed.

---

**Table 9–2  (Cont.) GL Cross Reference Fields and Description**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Cost Component      | Select the Cost Component from the following list:  
  - Freight  
  - Insurance  
  - Other Expenses |
| Credit Account Section  |  
  Segment      | The following fields are displayed in the Segment column:  
  - Natural Account  
  - Company  
  - Department  
  - Class  
  - Sub class  
  - Location  
  - Transfer Entity |
| Dynamic Indicator   | Select the check box. This signifies whether the segment is dynamic or generic. |
| Dynamic Attribute   | This field is enabled if Dynamic Indicator is selected as Y. |
| Value               | This field is enabled if Dynamic Indicator is selected as N. |

**Debit Account Section  
  Segment** The following fields are displayed in the Segment column:

- Natural Account
- Company
- Department
- Class
- Sub class
- Location
- Transfer Entity

**Dynamic Indicator** Select the check box. This signifies whether the segment is dynamic or generic.

**Dynamic Attribute** This field is enabled if Dynamic Indicator is selected as Y.

**Value** This field is enabled if Dynamic Indicator is selected as N.
10. Click **Cancel** to undo the changes you specified in the multi-record block.

**Note:** Only the fields that are setup in FM_TRAN_CODES table in the REF_NO fields are enabled as shown in Figure 9–5. That is, if tran_code 100 has REF_NO_1 field set as T - Only Tax code field is enabled. Other possible configurable values include, CC for Cost components, R for Reason Codes, U for Utilization Code.

**Chart of Accounts**

Chart of Accounts (COAs) is the grouping of data elements that define how the company’s financial statements are structured and managed. Some of the elements in the COAs include Natural Account (Assets, Liabilities, and so on), Cost Center, Company, Affiliate, Ledger, and so on. The structure of the General Ledger (GL) is based on the financial COAs.

For more information on set up of Chart of Accounts, see *Oracle Retail Fiscal Management/RMS Brazil Localization Implementation Guide*. 
The Direct NF and Free Form NF Requisition types distinguish StandAlone NFs from other NFs created within ORFM.

You can choose Direct NF Requisition type to create StandAlone NF using items, locations, and other fiscal entities (supplier, partner, finisher, transporter, and so on) that are defined in RMS.

You can choose Free Form NF Requisition type to add generic items or services that are not present in RMS to the NF, or use fiscal entities that are not defined in RMS. The Free Form NF allows you to enter a description for each item or service added to the NF.

The Source Details and Destination Details tabs in the Fiscal Documents Window are enabled only for both Free Form and Direct NF. The Additional Taxes Info tab is enabled only for Free Form NF.

The following fields are dimmed for requisition types other than Direct and Free Form NFs:

- Description
- State Inscription
- Tributary State
- Tributary Subscription No
- Neighborhood
- Country
- Entity in RMS

For more information on the Transportation Details tab, see Chapter 3, "Purchase Order".

This chapter covers the following links:

- Source Details Tab
- Destination Details Tab
- Detail Info Tab
- Additional Taxes Info Tab

**Source Details Tab**

*Figure 10–1* shows the Source Details Tab and the fields and description are provided in Table 10–1.
**Table 10–1 Fields and Description of Source Details Tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Type</td>
<td>You can select any one of the Source Type from the LOV.</td>
</tr>
<tr>
<td></td>
<td>The Source Type LOV includes Agent, Applicant, Bank, Bill To Location, Broker, Clearing Zone, Consignee, Consolidator, Customer, Discharge Port, Entry Port, Escheat - Country, Escheat - State, Expenses Vendor, External Finisher, Factory, Freight Forwarder, Import Authority, Importer, LC To Location, Lading Port, Return Center, Routing Location, Store, Supplier Site, Warehouse.</td>
</tr>
<tr>
<td>Source Description</td>
<td>This field is auto populated with the description of the Type selected.</td>
</tr>
<tr>
<td>State Inscription</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Tributary State</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Tributary Subscription No</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Name</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Address</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>City</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Zip</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Neighborhood</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>State</td>
<td>You can specify the field if the Entity in RMS check box is not selected. Else the field is dimmed.</td>
</tr>
<tr>
<td>Country</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>CNPJ/CPF</td>
<td>Enter the CNPJ/CPF number. This field is free form entry if Entity in RMS is not selected.</td>
</tr>
</tbody>
</table>
Table 10–2  Fields and Description of Destination Details Tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Destination Type</td>
<td>You can select any one of the Destination Type from the LOV. The Destination Type LOV includes store and warehouse.</td>
</tr>
<tr>
<td>Destination Description</td>
<td>This field is auto populated with the description of the Type selected.</td>
</tr>
<tr>
<td>State Inscription</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Tributary State</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Tributary Subscription No</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Name</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Address</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
</tbody>
</table>

Note:

- The Source Details tab is enabled only if Requisition Type is Direct NF or Free Form NF.
- It is mandatory to capture both Source and Destination Details for all StandAlone NFs.

Destination Details Tab

Figure 10–2 shows the Destination Details Tab and the fields and description are provided in Table 10–2.
Table 10–3  Fields and Description of Destination Details Tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>City</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Zip</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Neighborhood</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>State</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Country</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>CNPJ/CPF</td>
<td>Enter the CNPJ/CPF number. This field is free form entry if Entity in RMS is not selected.</td>
</tr>
<tr>
<td>Entity in RMS</td>
<td>You have an option to deselect the Entity in RMS check box, for an NF having requisition type Free Form NF. For a Direct NF, the Entity in RMS check box is selected and dimmed.</td>
</tr>
</tbody>
</table>

Note: The Destination Details tab is enabled only if Requisition Type is Direct NF or Free Form NF.

Detail Info Tab

Figure 10–3 shows the Detail Info Tab and the fields and description are provided in Table 10–3.

Figure 10–3  Detail Info Tab for Free Form NFs

Table 10–3  Fields and Description of Detail Info Tab for Free Form NFs

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service</td>
<td>This field is available only for Free Form NFs.</td>
</tr>
<tr>
<td>Service Code</td>
<td>This field is available only for Free form NFs and if the Service check box is selected.</td>
</tr>
</tbody>
</table>
Additional Taxes Info Tab

**Figure 10–4** shows the Additional Taxes Info Tab and the fields and description are provided in Table 10–4.

**Table 10–4  Fields and Description of Additional Taxes Info Tab for Free Form NFs**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>You can select the type from the list. It contains all type of taxes.</td>
</tr>
<tr>
<td>Mod.BC</td>
<td>Enter the mode of calculation value.</td>
</tr>
<tr>
<td>% MVA</td>
<td>Enter the value added margin percentage.</td>
</tr>
<tr>
<td>% Reduc.Base</td>
<td>Enter the reduced based percentage value.</td>
</tr>
</tbody>
</table>

For more information on Detail Info tab, see Chapter 3, "Purchase Order".
Additional Taxes Info Tab
The Invoice Receiving Layer (IRL) monitor is designed to support the new fiscal document generation process of XML files.

The IRL monitor allows you to follow the status and consult any error messages; adjust inconsistent data, insert missing data or associate documents that require manual association; revalidating a previous fiscal document has required intervention; or refuse a fiscal document preview that you do not want to adjust.

Depending on your system’s settings you may access all records regardless of the location or you must log in to a specific location.

**Navigate:** From the RMS Start Menu, select Fiscal Management > Invoice Receiving Layer. In the Contents of Invoice Receiving Layer, select IRL Monitor. The IRL Monitor appears.

**Options**

The Options Menu has been modified. See the sections listed below for more details about the available options of the IRL monitor.

**Status History Log**

The Status History Log option allows you to access the status history by which the XML file passed, from inception to physical receipt.

**Note:** This function cannot be executed for multiple records.

**Validation Errors Log**

The Validation Errors Log option allows you to access all messages resulting from any criticism of the validation. The messages allow you to analyze and decide to intervene in the document flow.

**Note:** This function cannot be executed for multiple records.

**Revalidate**

To revalidate an XML file that has already been validated and adjusted, use the Revalidate option to submit the file again. You can only revalidate fiscal document previews which are holding the status Adjusted and Waiting Revalidation.
Options

---

**Refusal**

During the XML pre-validation process, you may conclude that the document should not be received. Use the option Refusal option to reject the documents. You can only reject tax document previews holding one of the following status:

- Rejected in Pre-Validation
- Waiting Associate Document
- Rejected in EDI Validation

The system prompts for a reason for the refusal. Depending on your system’s configuration you may be able to justify the refusal in more details.

---

**Fiscal Document Preview Detail View**

You can consult the detail of information extracted from the XML file serving as a basis for the generation of the fiscal document. Depending on the status of the preview, you can edit information. You can edit documents holding one of the following status:

- Rejected In Pre-Validation
- Waiting Associate Document
- Rejected in EDI Validation

**Accessing the Fiscal Document Preview**

To access the fiscal document preview, follow the steps listed below.

**Navigate:** From the RMS Start Menu, select Fiscal Management > Invoice Receiving Layer. In the Contents Of Invoice Receiving Layer, select IRL Monitor. The IRL Monitor appears.

2. To edit the document, select **Options > Edit**.